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Manuals for This Machine
Read this manual carefully before you use this printer.

Refer to the manuals that are relevant to what you want to do with the printer.

• Media differ according to manual.

• The printed and electronic versions of a manual have the same contents.

• Adobe Acrobat Reader/Adobe Reader must be installed in order to view the manuals as PDF files.

• A Web browser must be installed in order to view the html manuals.

About This Machine

Before using the printer, be sure to read the section of this manual entitled Safety Information.

This manual introduces the printer’s various functions. It also explains the control panel, preparation
procedures for using the printer, how to enter text, how to install the CD-ROMs provided, and how
to replace paper, toner, staples, and other consumables.

Troubleshooting

Provides a guide for resolving common usage-related problems.

Printer Reference

Explains Printer functions and operations.

Network and System Settings Guide

Explains how to connect the printer to a network, configure and operate the printer in a network
environment, and use the software provided. Also explains how to change User Tools settings and
how to register information in the Address Book.

Security Reference

This manual is for administrators of the printer. It explains security functions that you can use to prevent
unauthorized use of the printer, data tampering, or information leakage. For enhanced security, we
recommend that you first make the following settings:

• Install the Device Certificate.

• Enable SSL (Secure Sockets Layer) Encryption.

• Change the user name and password of the administrator using Web Image Monitor.

• Change the password for printer settings using Web Interface.

For details, see “Setting Up the Machine”, Security Reference.

Be sure to read this manual when setting the enhanced security functions, or user and administrator
authentication.

Other manual

• Quick Reference Printer Guide

6



Notice

Important

In no event will the company be liable for direct, indirect, special, incidental, or consequential damages
as a result of handling or operating the machine.

For good print quality, the supplier recommends that you use genuine toner from the supplier.

The supplier shall not be responsible for any damage or expense that might result from the use of parts
other than genuine parts from the supplier with your office products.
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How to Read This Manual

Symbols

This manual uses the following symbols:

Indicates points to pay attention to when using the printer, and explanations of likely causes of paper
misfeeds, damage to originals, or loss of data. Be sure to read these explanations.

Indicates supplementary explanations of the printer's functions, and instructions on resolving user errors.

This symbol is located at the end of sections. It indicates where you can find further relevant information.

[ ]
Indicates the names of keys that appear on the printer's display panel.

[ ]
Indicates the names of keys on the printer's control panel.

Names of Major Items

Major options of this printer are referred to as follows in this manual:

• LCIT RT5030  LCT

• Finisher SR5000  Finisher

• Booklet Finisher SR5020  Booklet finisher

• Multi-Folding Unit FD5000  Multi-folding unit

• Trimmer Unit TR5020  Trimmer

About IP Address

• In this manual, “IP address” covers both IPv4 and IPv6 environments. Read the instructions that are
relevant to the environment you are using.

• Two IP addresses must be specified on this printer. For the IP address referred to as "system's IP address"
in this manual, enter the IP address that was specified in the System Settings menu. For "printer's IP
address", enter the IP address specified in the Printer Features menu.
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Note

Contents of this manual are subject to change without prior notice.

Some illustrations in this manual might be slightly different from the machine.

Certain options might not be available in some countries. For details, please contact your local dealer.

Depending on which country you are in, certain units may be optional. For details, please contact your
local dealer.

This printer comes in three models which vary in print speed. To ascertain which model you have, see
"Machine Types", About This Machine.
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Laws and Regulations

Legal Prohibition

Do not copy or print any item for which reproduction is prohibited by law.

Copying or printing the following items is generally prohibited by local law:

bank notes, revenue stamps, bonds, stock certificates, bank drafts, checks, passports, driver's licenses.

The preceding list is meant as a guide only and is not inclusive. We assume no responsibility for its
completeness or accuracy. If you have any questions concerning the legality of copying or printing certain
items, consult with your legal advisor.
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Model-Specific Information
In this manual, model-specific information is indicated by the following marks:

Indicates information that is specific to the 220 to 240 V model.

Indicates information that is specific to the 208 to 240 V model.

• Check the label behind the front cover of the printer to identify the model.

BTG013S

• Dimensions in this manual are given in two units of measure: metric and inch. If your printer is the 220
to 240 V model, refer to the metric units. If your printer is the 208 to 240 V model, refer to the inch
units.
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1. Preparing the Machine
This chapter describes how to connect this printer to your computer, and install the printer driver.

Connecting to the Interfaces
This section explains how to identify the printer's interface and connect the printer according to your network
environment.

This printer has two interfaces: the System Interface and the Printer Interface.

Connecting to the System Interface

This section explains how to use the system interface to connect the printer to a network.

BTH003D

1. Gigabit Ethernet port

Port for connecting the system/printer interface cable.

Do not tamper with the cable that is connecting these interfaces.

If this cable becomes unplugged, contact your service representative.

2. Ethernet port

Port for connecting the 100BASE-TX or 10BASE-T cable.

Connecting to the Ethernet Interface

This section describes how to connect Ethernet interface cable to the Ethernet interface.

13
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• If the main power switch is on, turn it off.

• Use the following Ethernet cables.

• Unshielded Twisted Pair Cable (UTP) or Shielded Twisted Pair Cable (STP) and Category type
5 or more

1. Make sure the main power is switched off.

2. Connect the 100BASE-TX/10BASE-T cable to the Ethernet port.

BTH018S

3. Connect the other end of the Ethernet interface cable to a network connection device such
as a hub.

4. Turn on the main power switch of the printer.

BTH021S

1

2

1. Indicator (yellow)

Lights up yellow when 100 BASE-TX is in operation. Goes off when 10 BASE-T is in operation.

2. Indicator (green)

Lights up green when 10 BASE-T is in operation. Goes off when 100 BASE-T is in operation.

• For details about how to turn on the main power switch, see "Turning On the Main Power", About
This Machine.

• For details about installing the printer driver, see "Installing the Printer Driver".

1. Preparing the Machine
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• p.22 "Installing the Printer Driver"

Connecting to the Printer Interface

This section explains how to use the printer interface to connect the printer to a network.

BTH017D

1. Gigabit Ethernet port

Port for connecting the system/printer interface cable.

Do not tamper with the cable that is connecting these interfaces.

If this cable becomes unplugged, contact your service representative.

2. IEEE 1284 port

Port for connecting the IEEE 1284 interface cable.

3. Gigabit Ethernet port

Port for using the 1000BASE-T, 100BASE-TX, or 10BASE-T cable.

Connecting to the IEEE 1284 Interface

This section describes how to connect the IEEE 1284 interface cable to the IEEE 1284 interface board.

Connecting to the Interfaces
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• For users outside the United States of America: properly shielded and grounded cables and
connectors must be used for connections to a host computer (and/or peripheral) in order to meet
emission limits.

• For users in the United States of America: properly shielded and grounded cables and connectors
must be used for connections to a host computer (and/or peripheral) in order to meet FCC emission
limits.

1. Make sure the main power is switched off.

2. Turn off the main power switch of the host computer.

3. Connect the IEEE 1284 interface cable to the IEEE 1284 port.

BTH020S

You might have to use a conversion adapter to connect the cable to the interface. For details about
acquiring a conversion adapter, consult your sales or service representative.

4. Connect the other end of the cable into the interface connector on the host computer.

Check the shape of the connector to the computer. Connect the cable firmly.

5. Turn on the main power switch of the printer.

6. Turn on the host computer.

A printer driver installation screen might appear when the computer is turned on. If this happens, click
[Cancel] on the screen.

• For details about how to turn on the main power switch, see "Turning On the Main Power", About
This Machine.

• For details about installing the printer driver, see "Installing the Printer Driver".

• p.22 "Installing the Printer Driver"

1. Preparing the Machine
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Connecting to the Gigabit Ethernet Interface

This section describes how to connect the Ethernet interface cable to the Gigabit Ethernet port.

• If the main power switch is on, turn it off.

• Use the following Ethernet cables.

• When using 100BASE-TX/10BASE-T:

Unshielded Twisted Pair Cable (UTP) or Shielded Twisted Pair Cable (STP) and Category type
5 or more

• When using 1000BASE-T:

Unshielded Twisted Pair Cable (UTP) or Shielded Twisted Pair Cable (STP) and Category type
5e or more

1. Make sure the main power is switched off.

2. Connect the Ethernet interface cable to the Gigabit Ethernet port.

BTH019S

3. Connect the other end of the Ethernet interface cable to a network connection device such
as a hub.

4. Turn on the main power switch of the printer.

BTH022S

1. Indicator (green)

When 10BASE-T is operating, the LED is lit green. When 100BASE-TX is operating it is turned off.

2. Indicators (both green and yellow)

When 1000BASE-T is operating, both LED are lit.

Connecting to the Interfaces
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3. Indicator (yellow)

When 100BASE-TX is operating, the LED is lit yellow. When 10BASE-T is operating, it is turned off.

• For details about how to turn on the main power switch, see "Turning On the Main Power", About
This Machine.

• For details about installing the printer driver, see "Installing the Printer Driver".

• For details about interface settings, see "Administrator Configuration".

• p.22 "Installing the Printer Driver"

• p.103 "Administrator Configuration"

1. Preparing the Machine
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Confirming the Connection Method
This printer supports network and local connection.

Before installing the printer driver, check how the printer is connected. Follow the driver installation
procedure that is appropriate to the connection method.

Network Connection

This printer can be used as a Windows printing port or network printer.

Using this machine as the Windows printing port

Network connections can be established through Ethernet.

Available ports are determined based on the combination of Windows operating system version and
connection method used.

BTG056S

Windows 2000/XP, Windows Server 2003/2003 R2

Connection Method Available Ports

• Ethernet • Standard TCP/IP port

• LPR port

• IPP port

Confirming the Connection Method
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Windows Vista/7, Windows Server 2008/2008 R2

Connection Method Available Ports

• Ethernet • Standard TCP/IP port

• LPR port

• See the explanation about how to install the printer driver for each type of port.

• For details about Standard TCP/IP port, see "Installing the Printer Driver (Standard TCP/IP Port)".

• For details about LPR port, see "Installing the Printer Driver (LPR Port)".

• For details about IPP port, see "Installing the Printer Driver (IPP Port)".

• p.23 "Installing the Printer Driver (Standard TCP/IP Port)"

• p.26 "Installing the Printer Driver (LPR Port)"

• p.28 "Installing the Printer Driver (IPP Port)"

Using as a network printer

This printer can be used as the Windows network printer.

BTG057S

• See the explanation about how to install the printer driver for each type of network printer.

1. Preparing the Machine
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• For details about Windows network printer, see "Using as a Windows Network Printer" or "Preparing
Printer Server".

• p.29 "Using this Printer as a Windows Network Printer"

• p.143 "Preparing Printer Server"

Local Connection

Local connections can be established via parallel connections.

• See the explanation about how to install the printer driver for each method of connections.

• For details about parallel connections, see "Printing with Parallel Connection".

• p.30 "Printing with Parallel Connection"

Confirming the Connection Method
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Installing the Printer Driver
This section explains how to install the printer driver.

You can install the printer driver from the CD-ROM provided with this printer or download it from the
supplier's Web site.

The printer driver for the following operating systems must be downloaded from the supplier's Web site:

• Windows XP Professional x64

• Windows Vista x64

• Microsoft Windows 7 x64

• Windows Server 2003/2003 R2/2008 x64

• Microsoft Windows Server 2008 R2

To download the printer driver, visit the supplier's Web site. On the site, select this printer and the operating
system you are using, and then download the appropriate driver.

Operating Environment

This section describes the operating environment required to use the printer driver.

Supported Operating Systems

• Microsoft Windows 2000

• Microsoft Windows XP Service Pack 1 or later

• Microsoft Windows XP x64 Service Pack 1 or later

• Microsoft Windows Server 2003

• Microsoft Windows Server 2003 x64

• Microsoft Windows Server 2003 R2

• Microsoft Windows Server 2003 R2 x64

• Microsoft Windows Vista

• Microsoft Windows Vista x64

• Microsoft Windows 7

• Microsoft Windows 7 x64

• Microsoft Windows Server 2008

• Microsoft Windows Server 2008 x64

• Microsoft Windows Server 2008 R2

Supported Page Description Language

• PostScript 3

1. Preparing the Machine
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• PCL5e

• PCLXL

Installing Simple Network Management Protocol (SNMP)

Use the following procedure to install Simple Network Management Protocol (SNMP) on your computer.
(Note that this procedure is based on Windows XP. The procedure might differ slightly depending on the
operating system you are using.)

SNMP is required to establish bidirectional communication between the printer and your computer. Install
SNMP before installing the printer driver, and configure SNMP Trap service to activate automatically.

1. On the [Start] menu, click [Control Panel], and then click [Add or Remove Programs].

2. Click [Add/Remove Windows Components], and then click [Management and Monitoring
Tools] in the [Components] list to make it appear highlighted. Then click [Details...].

3. Select the [Simple Network Management Protocol] check box, and then click [OK].

4. Click [Next>].

The installation starts.

During the installation, you may be asked to specify the location of the source directory for the system
files. Follow the instructions on the display to proceed.

5. Click [Finish].

6. Close the [Add or Remove Programs] dialog box.

7. Click [Performance and Maintenance] in the Control Panel, and then click [Administrative
Tools].

8. Double-click [Services].

The [Services] dialog box appears.

9. Double-click [SNMP Trap Service].

10. In the [Startup Type:] pop-up menu, select [Automatic].

11. Click [Start].

12. Click [OK].

Close the [Services] dialog box.

Installing the Printer Driver (Standard TCP/IP Port)

Use the following procedure to install the printer driver using the TCP/IP port. (Note that this procedure is
based on Windows XP. The procedure might differ slightly depending on the operating system you are
using.)

Installing the Printer Driver
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• You need administrator permissions to install the driver. Log on as an Administrators group member.

• The Standard TCP/IP Port is not available if you are running Windows XP/7 or Windows Server
2003/2003 R2/2008 R2 in an IPv6 environment.

1. Close all applications currently running.

2. Insert the CD-ROM in the CD-ROM drive.

The installer starts.

Auto Run may not work if certain operating system settings are configured. If this is the case, launch
"Setup.exe" from the CD-ROM root directory.

3. Select the interface language, and then click [OK].

4. Click [M Driver].

The Add Printer wizard starts.

5. Click [Next>].

6. Select [Local printer attached to this computer], and then click [Next>].

7. Click [Create a new port:], and then select [Standard TCP/IP Port] in the [Type of port] list.

8. Click [Next>].

The Add Standard TCP/IP Printer Port wizard starts.

9. Click [Next>].

10. In the [Printer Name or IP Address] box, enter the printer's name or printer's IP address. The
[Port Name] text box is filled automatically.

11. Change the port name if necessary, and then click [Next>].

The device type selection dialog box appears.

If the "Completing the Add Standard TCP/IP Printer Port Wizard" message appears, the port must be
configured after the installation is complete. Proceed to step 17 to continue with the installation. When
the installation is complete, be sure to configure the port correctly. For the procedure for configuring
the port, see "Configuring the Port Settings".

12. Select [Custom] in the [Device Type] area, and then click [Settings...].

The [Configure Standard TCP/IP Port Monitor] dialog box appears.

13. Select [LPR] in the [Protocol] area, and then enter a virtual printer name in the [Queue Name]
box under [LPR Setting].

Specify the virtual printer name that matches the page description language you require:

• PostScript: postscript

• PCLXL: pclxl

• PCL5e: vp-pcl

1. Preparing the Machine
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14. Select the [LPR Byte Counting Enabled] check box, and then clear the [SNMP Status Enabled]
check box.

15. Click [OK].

The [Add Standard TCP/IP Printer Port Wizard] dialog box reappears.

16. Click [Next>].

17. Click [Finish].

The [Add Printer Wizard] dialog box reappears.

18. Click [Have Disk...], and then click [Browse...].

19. Select the printer setup information file for the printer driver, and then click [OK].

If the CD-ROM drive letter is D, the printer driver's setup information file (Printer.inf) is stored in "D:
\DRIVERS\Mdriver\(Language)\".

20. Select the printer you want to add, and then click [Next>].

21. Change the printer name if necessary.

22. To use this printer as the default printer, select [Yes], and then click [Next>].

23. To share the printer over a network, select [Share Name], and then specify the printer's
name. If you do not want to share the printer over a network, select [Do not share this
printer], and then click [Next>].

24. If you selected [Share Name], complete the text boxes, and then click [Next>].

25. If a message asking you whether or not you want to print a test message appears, select
[No], and then click [Next>].

You must finish the installation before printing a test page.

26. Click [Finish].

If the [Software Installation] dialog box appears, click [Continue Anyway].

• To stop the installation of the driver, click [Cancel] before the installation is complete.

• p.41 "Setting the Virtual Printer"

Configuring the Port Settings

Use the following procedure to configure the port settings for the printer driver that is already installed.

1. On the [Start] menu, click [Control Panel], and then click [Printers and Faxes] in the [Printers
and Other Hardware] category.

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use.

Installing the Printer Driver
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3. On the [File] menu, click [Properties].

The printer properties dialog box appears.

4. Click the [Ports] tab, and then click [Configure Port...].

5. Select [LPR] in the [Protocol] area, and then enter a virtual printer name in the [Queue Name]
box under [LPR Setting].

Specify the virtual printer name that matches the page description language you require:

• PostScript: postscript

• PCLXL: pclxl

• PCL5e: vp-pcl

6. Select the [LPR Byte Counting Enabled] check box, and then clear the [SNMP Status Enabled]
check box.

7. Click [OK].

8. Click [Close].

• p.41 "Setting the Virtual Printer"

Installing the Printer Driver (LPR Port)

Use the following procedure to install the printer driver using the LPR port. (Note that this procedure is based
on Windows XP. The procedure might differ slightly depending on the operating system you are using.)

• You need the administrator permissions to install the driver. Log on as an Administrators group member.

• The LPR Port is not available if you are running Windows XP/7 or Windows Server 2003/2003
R2/2008 R2 in an IPv6 environment.

1. Close all applications currently running.

2. Insert the CD-ROM in the CD-ROM drive.

The installer starts.

Auto Run may not work if certain operating system settings are configured. If this is the case, launch
"Setup.exe" from the CD-ROM root directory.

3. Select the interface language, and then click [OK].

4. Click [M Driver].

The Add Printer wizard starts.

5. Click [Next>].

6. Select [Local printer attached to this computer], and then click [Next>].

1. Preparing the Machine
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7. Click [Create a new port:], and then select [LPR Port] in the [Type of port] list.

If [LPR Port] does not appear in the list, see Windows Help and install it.

8. Click [Next>].

The [Add LPR Compatible Printer] dialog box appears.

9. In the [Name or address of server providing lpd] box, enter the printer's IP address.

10. In the [Name of printer or print queue on that server] box, enter a virtual printer name, and
then click [OK].

Specify the virtual printer name that matches the page description language you require:

• PostScript: postscript

• PCLXL: pclxl

• PCL5e: vp-pcl

11. Click [Have Disk...], and then click [Browse...].

12. Select the printer setup information file for the printer driver, and then click [OK].

If the CD-ROM drive letter is D, the printer driver's setup information file (Printer.inf) is stored in "D:
\DRIVERS\MDriver\(Language)\".

13. Select the printer model you want to add, and then click [Next>].

14. Change the printer name if necessary.

15. To use this printer as the default printer, select [Yes], and then click [Next>].

16. To share the printer over a network, select [Share Name], and then enter the printer's name.
If you do not want to share the printer over a network, select [Do not share this printer],
and then click [Next>].

17. If you selected [Share Name], complete the text boxes, and then click [Next>].

18. If a message asking you whether or not you want to print a test message appears, select
[No], and then click [Next>].

You must finish the installation before printing a test page.

19. Click [Finish].

If the [Software Installation] dialog box appears, click [Continue Anyway].

• To stop the installation of the driver, click [Cancel] before the installation is complete.

• p.41 "Setting the Virtual Printer"

Installing the Printer Driver

27

1



Installing the Printer Driver (IPP Port)

Use the following procedure to install the printer driver using the IPP port. (Note that this procedure is based
on Windows XP. The procedure might differ slightly depending on the operating system you are using.)

• IPP port is supported by Windows 2000/XP and Windows Server 2003/2003 R2.

1. Close all applications currently running.

2. Insert the CD-ROM in the CD-ROM drive.

The installer starts.

Auto Run may not work if certain operating system settings are configured. If this is the case, launch
"Setup.exe" from the CD-ROM root directory.

3. Select the interface language, and then click [OK].

4. Click [M Driver].

The Add Printer wizard starts.

5. Click [Next>].

6. Click [A network printer, or a printer attached to another computer], and then click [Next>].

7. Select [Connect to a printer on the Internet or on a home or office network], and then, in the
[URL] box, enter "http://(printer's IP address)/".

If server authentication is issued, enter "https://(printer's IP address)/" to enable encryption by SSL.
Internet Explorer must be installed on your computer. We recommend you install the latest version
(Internet Explorer 6.0 or higher).

8. Click [Next>].

If the [Configure Internet Port] dialog box appears, specify the account information for the network.
For the account information, consult your administrator.

9. Click [Have Disk...], and then click [Browse...].

10. Select the setup information file for the printer driver, and then click [OK].

If the CD-ROM drive letter is D, the printer driver's setup information file (Printer.inf) is stored in "D:
\DRIVERS\MDriver\(Language)\".

11. Select the printer you want to add, and then click [OK].

12. To use this printer as the default printer, select [Yes], and then click [Next>].

13. Click [Finish].

• To stop the installation of the driver, click [Cancel] before the installation is complete.

1. Preparing the Machine
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Using this Printer as a Windows Network Printer
This section describes how to install the printer driver when using the printer as a Windows network printer.
(Note that this procedure is based on Windows XP. The procedure might differ slightly depending on the
operating system you are using.)

• If your operating system is Windows XP Professional/Vista x64 or Windows Server 2003/2003
R2/2008 x64, you must download the printer driver from the supplier's Web site. Select this printer
and the operating system you are using, and then download the appropriate driver.

1. Close all applications currently running.

2. Insert the CD-ROM in the CD-ROM drive.

The installer starts.

Auto Run may not work if certain operating system settings are configured. If this is the case, launch
"Setup.exe" from the CD-ROM root directory.

3. Select the interface language, and then click [OK].

4. Click [M Driver].

The Add Printer wizard starts.

5. Click [Next>].

6. Click [A network printer, or a printer attached to another computer], and then click [Next>].

7. Select [Browse for a Printer], and then click [Next>].

8. In the [Browse for a Printer] window, double-click the name of the computer you want to
use as the print server.

9. Select the printer you want to install, and then click [Next>].

10. If a confirmation dialog box appears, click [Yes].

11. To use this printer as the default printer, select [Yes], and then click [Next>].

12. Click [Finish].

• To stop the installation of the driver, click [Cancel] before the installation is complete.

• For the installation to complete successfully, the Windows network printer must be correctly configured.
For details about the Windows network printer settings, see "Preparing Printer Server".

• p.143 "Preparing Printer Server"
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Printing with Parallel Connection
This section explains how to install the printer driver using the parallel port. (Note that this procedure is
based on Windows XP. The procedure might differ slightly depending on the operating system you are
using.)

To use a printer connected using a parallel interface, click [LPT1] when installing the printer driver.

• You need administrator permissions to install the driver. Log on as an Administrators group member.

• If your operating system is Windows XP Professional/Vista x64, Windows Server 2003/2003
R2/2008 x64, you must download the printer driver from the supplier's Web site. Select this printer
and the operating system you are using, and then download the appropriate driver.

1. Close all applications currently running.

2. Insert the CD-ROM in the CD-ROM drive.

The installer starts.

Auto Run may not work if certain operating system settings are configured. If this is the case, launch
"Setup.exe" from the CD-ROM root directory.

3. Select the interface language, and then click [OK].

4. Click [M Driver].

The Add Printer wizard starts.

5. Click [Next>].

6. Select [Local printer attached to this computer], and then click [Next>].

7. Select [LPT1: (Recommended Printer Port)] in the [Use the following port] list, and then click
[Next>].

8. Click [Have Disk...], and then click [Browse...].

If the CD-ROM drive letter is D, the printer driver’s setup information file (Printer.inf) is stored in "D:
\DRIVERS\MDriver\(Language)\".

9. Change the printer name if necessary.

10. To use this printer as the default printer, select [Yes], and then click [Next>].

11. To share this printer over a network, select [Share Name], and then click [Next>]. If you do
not want to share the printer over a network, select [Do not share this printer], and then
click [Next>].

12. If you selected [Share Name], complete the text boxes, and then click [Next>].

13. If a message asking you whether or not you want to print a test message appears, select
[No], and then click [Next>].

You must finish the installation before printing a test page.
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14. Click [Finish].

If the [Software Installation] dialog box appears, click [Continue Anyway].

• To stop the installation of the driver, click [Cancel] before the installation is complete.
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Uninstalling the Printer Driver
This section describes how to uninstall the printer driver. (Note that this procedure is based on Windows
XP. The procedure might differ slightly depending on the operating system you are using.)

Deleting the Printer Driver

Use the following procedure to delete the printer driver files from your system.

• You need the administrator permissions to uninstall the driver. Log on as an Administrators group
member.

1. On the [Start] menu, click [Control Panel], and then click [Printers and Faxes] in the [Printers
and Other Hardware] category.

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to uninstall.

3. On the [File] menu, click [Delete].

A confirmation dialog box appears.

4. Click [Yes].

The printer icon disappears from the list.

5. Restart your computer.

6. On the [Start] menu, click [Control Panel], and then click [Printers and Faxes] in the [Printers
and Other Hardware] category.

The [Printers and Faxes] window appears.

7. On the [File] menu, select [Server Properties].

The [Printer Server Properties] dialog box appears.

8. Click the [Drivers] tab.

9. Select this printer in the [Installed printer drivers] list, and then click [Remove].

A confirmation dialog box appears.

10. Click [Yes].

11. Click [Close].

Removing the Registry Information

Use the following procedure to remove the registry information created by the printer driver.

1. Preparing the Machine
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• You need administrator permissions to remove information from the registry. Log on as an
Administrators group member.

• Uninstall the printer driver using the [Printer and Faxes] dialog box before removing the registry
information. For details about how to delete the printer driver, see "Deleting the Printer Driver".

1. Insert the CD-ROM in the CD-ROM drive.

The installer starts.

Auto Run may not work if certain operating system settings are configured. If this is the case, launch
"Setup.exe" from the CD-ROM root directory.

2. Select the interface language, and then click [OK].

3. Click [Browse This CD-ROM].

The content of the CD-ROM root directory is displayed.

4. Open the directory containing the setup information file required to remove the registry
information (DeleteReg.inf).

DeleteReg.inf is stored under "DRIVERS\MDriver\Uninstall".

5. Right click the DeleteReg.inf file, and then click [Install].

The registry information for this printer will be removed from the system.

6. Restart your computer.

• p.32 "Deleting the Printer Driver"
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Displaying the Printer Driver Settings Screen
This section explains how to open and configure the printer driver properties. (Note that this procedure is
based on Windows XP. The procedure might differ slightly depending on the operating system you are
using.)

Making Printer Default Settings - the Printer Properties

• To change the printer's default settings (including settings for options), log on using an account that
has Manage Printers permission. Members of the Administrators groups have Manage Printers
permission by default.

• You cannot change the printer default settings for individual users. Settings made in the printer
properties dialog box are applied to all users.

1. On the [Start] menu, click [Control Panel], and then click [Printers and Faxes] in the [Printers
and Other Hardware] category.

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

The printer properties dialog box appears.

4. Make the settings you require, and then click [OK].

• The settings you make here are used as the default settings for all applications.

• For details, see the printer driver Help.

Making Printer Default Settings - Printing Preferences Properties

• The settings in the "Printing Settings" (Document Properties) dialog box that can be modified and
retained differ depending on the printer driver, printer icon, and the users registered for each printer
icon.

1. On the [Start] menu, click [Control Panel], and then click [Printers and Faxes] in the [Printers
and Other Hardware] category.

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use.
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3. On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

4. Click [Properties...].

5. Make the settings you require, and then click [OK].

• The settings you make here are used as the default settings for all applications.

• For details, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printing preferences properties dialog box
from that application. The following procedure explains how to make printer settings for a specific
application using Windows XP WordPad as an example.

1. On the [File] menu, click [Print...].

The [Print] dialog box appears.

2. In the [Select Printer] list, select the printer you want to use.

3. Click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

4. Click [Properties...].

5. Make the settings you require, and then click [OK].

• Procedures for opening the printing preferences properties dialog box vary depending on the
application. For details, see the manuals provided with the application.

• Any settings you make using this procedure apply to the current application only.

• General users can change the printing preferences properties displayed in the [Print] dialog box of
an application. Settings made here are used as the defaults when printing from the application.

• For details, see the printer driver Help.
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Configuring Printer Options
This section explains how to configure the printer's options using the printer driver.

Before printing, make sure that the settings for the installed options and loaded paper are set correctly.

Configuring the Options

Use the following procedure to configure the printer options using the printer driver. (Note that this
procedure is based on Windows XP. The procedure might differ slightly depending on the operating system
you are using.)

• You need administrator permissions to change option settings. Log on as an Administrators group
member.

1. On the [Start] menu, click [Control Panel], and then click [Printers and Faxes] in the [Printers
and Other Hardware] category.

The [Printers and Faxes] window appears.

2. Click the icon for this printer, and then select [Properties] on the [File] menu.

The printer properties dialog box appears.

3. Click the [Device Settings] tab, and then click [Settings...] in the [Accessories] area.

4. Select the attached options, such as the paper trays and finisher.

If the Printer Monitor is active, you can update option information simply by clicking [Update].

5. If you want to change the paper settings, click [Paper source tray settings] on the menu list,
and then change the paper settings as necessary.

6. Click [OK].

The printer properties dialog box reappears.

7. Click [OK].

• When you have finished configuring option settings, be sure to configure paper-related settings such
as size, type, and color in the [Paper source tray settings] list.

• If you have changed option settings by clicking the [Update] button, do not then change the settings
again manually. If you have already changed the settings manually, click the [Update] button again
to ensure the option settings are correctly configured.

• If the [Update] button is inactive, the Printer Monitor is not available and bidirectional communication
is disabled. To activate the Printer Monitor, see "Activating the Printer Monitor". For details about what
is required for bidirectional communication to be enabled, see "Conditions for Bidirectional
communication".
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• p.37 " Activating the Printer Monitor"

• p.39 "Conditions for Bidirectional Communication"

Switching the Page Description Language

Use the following procedure to change the page description language.

Note that the printer driver provided with this printer can be used for all the page description languages
(PostScript, PCLXL and PCL5e) supported by the printer.

The default page description language is PostScript.

1. On the [Start] menu, click [Control Panel], and then click [Printers and Faxes] in the [Printers
and Other Hardware] category.

The [Printers and Faxes] window appears.

2. Select the icon for this printer, and then click [Properties] on the [File] menu.

The printer properties dialog box appears.

3. Click the [Device Settings] tab, and then click [Settings...] in the [Printer Monitor/Page
Description Language] area.

The [Printer Installer] dialog box appears.

A confirmation dialog asking you whether or not you want to activate the Printer Monitor appears.
The following steps apply when you select "No".

4. Select the page description language you want to use, and then click [Next>].

5. Click [Finish].

• To enable the Printer Monitor, see "Activating the Printer Monitor".

• p.37 " Activating the Printer Monitor"

Activating the Printer Monitor

This section explains the Printer Monitor.

When the Printer Monitor is active, information such as the printer's status and the status of print jobs sent
from applications can be monitored.

If the printer driver is configured to monitor print jobs, the Printer Monitor starts whenever a print job is
received and monitors all the events that occur while printing is in progress. The printer driver can be
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configured to notify the user with a warning massage and/or alert sound in the event of an error such as
a paper jam.

• In an IPv6 environment, you cannot use the Printer Monitor.

• The Printer Monitor monitors print jobs sent to virtual printers only.

• For details about virtual printer settings, see "Setting the Virtual Printer".

• p.41 "Setting the Virtual Printer"

Specifying a Virtual Printer

Use the following procedure to enable the Printer Monitor using the printer driver and to specify the virtual
printer to be used.

• In an IPv6 environment, you cannot use the Printer Monitor.

• To activate the Printer Monitor, [SNMP Trap Service] must be enabled in the [Simple Network
Management Protocol] dialog box. If Simple Network Management Protocol is not installed on your
computer, uninstall the printer driver and then install SNMP. For details, see “Uninstalling the Printer
Driver” and “Installing Simple Network Management Protocol (SNMP)”.

1. On the [Start] menu, click [Control Panel], and then click [Printers and Faxes] in the [Printers
and Other Hardware] category.

The [Printers and Faxes] window appears.

2. Select the icon for this printer, and then click [Properties] on the [File] menu.

The printer properties dialog box appears.

3. Click the [Device Settings] tab, and then click [Settings...] in the [Printer Monitor/Page
Description Language] area.

The [Printer Installer] dialog box appears.

4. Select [Yes], and then click [Next>].

5. To acquire the virtual printer information automatically, click [Detect...]. When configuring
the virtual printer manually, enter the printer's IP address and the name of the virtual printer
to be used.

The [Detect...] button is effective only when the name of the virtual printer matches the queue name
selected in the "LPR Settings" on the [Ports] tab in the [Configure Standard TCP/IP Port Monitor] dialog
box.
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6. Click [Next>].

The page description language supported by the specified virtual printer is selected automatically.

7. Click [Next>].

8. Click [Finish].

• Depending on the firewall settings of your operating system, the virtual printer might not be
automatically detected. For details about firewall settings, see "Configuring the Firewall".

• If the print job finishes without error, the Printer Monitor is automatically terminated. However, if an
error occurs during the print process, or if the Printer Monitor window was maximized, the Printer
Monitor continues monitoring.

• For details about enabling monitoring of print jobs, see the printer driver Help.

• For details about Printer Monitor settings, see the Printer Monitor Help.

• p.23 "Installing Simple Network Management Protocol (SNMP)"

• p.32 "Uninstalling the Printer Driver"

• p.39 "Configuring the Firewall"

Conditions for Bidirectional Communication

This section explains the conditions required for bidirectional communication to be enabled.

When the Printer Monitor is set to active, the printer and your computer establish bidirectional
communication. Bidirectional communication allows information such as option settings to be automatically
sent to the printer driver and changed accordingly.

To enable bidirectional communication, the following conditions must be met:

• The printer and computer are connected through a network.

• The connection is through a Standard TCP/IP, IPR, or IPP port.

• The Printer Monitor is enabled.

• The Printer Monitor is not available when using parallel connection is enabled.

Configuring the Firewall

If you want to use the printer auto detection and monitoring functions on a computer that is protected by a
firewall application, some firewall settings might have to be changed.
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For example, the following firewall-related problems can occur if your computer is running Windows XP
SP2 under its default settings:

• The printer is not automatically detected when you click the [Detect...] button.

• Error information and the status of the print job do not appear in the Printer Monitor event list.

Use the following procedure to resolve these problems.

1. On the [Start] menu, click [Control Panel], and then click [Windows Firewall] in the [Security
Center] category.

2. Select the [Exceptions] tab, and then click [Add port...].

3. Enter “162” in the [Port number] box, and then click [UDP].

4. Enter the [Name] for this port.

To allow connection from only the printer you are using and block connections from any other devices,
click [Change scope...]. Then click [Custom list:], and then enter the printer’s IP address.

5. Click [OK].

The name of the port added in step 4 appears in the [Program or port] list.

6. Select the check box of the newly added port, and then click [OK].

• If you are using Windows Vista, and [WinSNMP DLL Support Application Release#xx] appears in
the [Program or port] list, select its check box, and then click [OK] to close the [Windows Firewall
Settings] dialog box.

• For details, see Windows Help.

1. Preparing the Machine

40

1



Setting the Virtual Printer
This section explains the virtual printer function.

The virtual printer is a pseudo printer that can only be recognized on a network. The virtual printer has
various print options, such as feeding tray selection and page description language, which you can set in
advance.

If you use the virtual printer under UNIX, Solaris, and other operating systems, various print functions are
possible without your having to manually enter the usual print commands.

• Only the administrator can configure virtual printer settings. The password for printer settings is
required to change these settings.

• p.37 " Activating the Printer Monitor"

Adding a Virtual Printer

Use the following procedure to add a virtual printer.

1. Open the Web browser.

2. Enter “http://(printer's IP address or host name of this printer)/” in the address bar.

The top page of Web Interface is displayed.

3. Click [Configurations/Jobs].

A dialog box for entering the user name and password appears.

4. Enter “system” in the user name box and the password for printer settings in the password
box, and then click [OK].

A list of virtual printers is displayed.

5. Click [Add].

Select the printer that you want to use as a virtual printer.

To continue changing the virtual printer configuration, proceed to Step 6 under “Changing a Virtual
Printer's Configuration”.

• p.41 "Changing a Virtual Printer's Configuration"

Changing a Virtual Printer's Configuration

Use this procedure to change a virtual printer configuration.
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1. Open the Web browser.

2. Enter “http://(printer's IP address or host name of this printer)/” in the address bar.

The top page of Web Interface is displayed.

3. Click [Configurations/Jobs].

A dialog box for entering the user name and password appears.

4. Enter “system” in the user name box and the password for printer settings in the password
box, and then click [OK].

A list of virtual printers is displayed.

5. Select the virtual printer whose settings you want to change, and then click [Change].

The categories that can be modified are displayed.

6. Click [Change] in the category you want to modify.

7. Modify the settings in each item as desired, and then click [OK].

8. Click [Back].

• For details about virtual printer configurations, see Web Interface help.

Deleting a Virtual Printer

Use this procedure to delete a virtual printer.

1. Open the Web browser.

2. Enter “http://(printer's IP address or host name of this printer)/” in the address bar.

The top page of Web Interface is displayed.

3. Click [Configurations/Jobs].

A dialog box for entering the user name and password appears.

4. Enter “system” in the user name box and the password for printer settings in the password
box, and then click [OK].

A list of virtual printers is displayed.

5. Select the virtual printer you want to change the setting, and then click [Delete].

A confirmation message appears.

6. Click [OK].

• You cannot delete the default virtual printer.
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Printing Using a Virtual Printer

This section explains how to print documents using a virtual printer.

There are two methods of printing from a virtual printer: by printer driver and by print commands.

To print from a virtual printer using the printer driver, see "Installing the Printer Driver (Standard TCP/IP
Port)".

To print from a virtual printer using print commands, enter the following commands from your computer's
command line:

lpr

C:\>lpr -S "printer's IP address" -P “Virtual Printer Name” [-ol] \path\file name

• p.23 "Installing the Printer Driver (Standard TCP/IP Port)"
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2. Printing Documents
This chapter explains how to print documents using the printer driver. It also describes the procedure for
configuring staple, punch, fold and other printing functions.

Frequently Used Print Methods
This section explains how to use the various printing functions including normal printing, duplex printing,
and staple printing.

Each function described in this chapter is configured and registered under "Profiles". You can also change
the parameters for each function by modifying "Profiles".

The following procedure explains how to make printer settings for a specific application using Windows
XP WordPad as an example.

• Before printing, make sure that the settings for the installed options and loaded paper are correctly
configured. For details about configuring the options, see "Configuring the Options".

• When printing data containing different page sizes, for the following combinations, the vertical
orientation of the output will vary.

• paper orientation: LEF; print direction: Portrait

• paper orientation: SEF; print direction: Landscape

• For details about Profiles, see "Using Profiles".

• p.36 "Configuring the Options"

• p.53 "Using Profiles"

Standard Printing

Use the following procedure to print documents using normal printing functions from the printer driver.

1. After creating a document, click [Print...] on the [File] menu of the document's native
application.

The [Print] dialog box appears.

2. Select the icon for this printer, and then click [Preferences].

The [Printing Preferences] dialog box appears.
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3. Click [Properties...].

The printing preferences properties dialog box appears.

4. In the [Original Size:] list, select the paper size of the document you want to print.

5. In the [Original orientation:] area, select [Portrait] or [Landscape] as the orientation of the
original.

6. In the [Paper source tray:] list, select the paper tray that contains the paper you want to
print onto.

7. Select the type and color of the paper loaded in the paper tray by selecting the appropriate
item in each list.

If you select [Auto Tray Select] in the [Paper source tray:] list, the source tray is automatically selected
according to the paper size, type and color specified.

8. Change the [Paper output tray:] setting if necessary.

9. If PCL5e is selected as the page description language, click [Job Options] in the menu list,
and then select [Normal Print] in the [Output to:] list.

10. Click [OK].

The [Printing Preferences] dialog box reappears.

11. Click [OK].

12. Click [Print].

• To select a custom paper size in step 4, click the [Custom Paper Size...] button, and then specify the
paper size settings. For details about other settings, see the printer driver Help.

• If you have specified a source tray and selected PostScript as the page description language in the
printer driver, paper will be fed in from the specified source tray and printed on. This will happen even
if the paper size specified in the driver does not match the size of the paper loaded in the source tray.
Similarly, the paper type and color settings specified in the driver will also be ignored. For details,
see "Alt. Paper Size with Reduced Print Image" for "PS / PDF Menu".

• If there is no tray matching the specified paper size, type, or color, or if the paper loaded in the printer
has run out, a warning message might appear on the control panel. If it does, load paper matching
the specified print settings into a tray, or press [Job Reset] to cancel printing. For details, see "If Paper
Size, Type, and Color Errors Occur".

• If you have specified a source tray and selected PostScript as the page description language in the
printer driver, the paper loaded in the specified source tray will be printed on. This will happen even
if the paper size specified in the driver does not match the size of the paper loaded in the source tray.
Similarly, any paper type and color settings specified in the driver will also be ignored.

• p.72 "If Paper Size, Type, and Color Errors Occur"

• p.98 "PS / PDF Menu"
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Selecting the paper type using the printer driver

This section explains how to select the paper types using the printer driver.

The paper types that can be selected when printing documents are set using the printer driver. The types
of the paper loaded in the paper trays are indicated on the printer’s control panel. You can check the
selected paper type is loaded in which tray.

However, the paper type setting available in the printing preference dialog box may be different from the
type indicated on the printer’s control panel. Before selecting the paper type using the printer driver, check
the type of the paper loaded in each tray.

To change the paper size, type, and color specified in the printer driver, change the settings using the
example procedure shown under "Configuring the Options".

• If you want to select [Plain] in the printer driver, select [Do not Display] in the [Paper Type] list. In this
case, the paper type will not be displayed on the printer's control panel.

• For the procedure to change the paper type settings, see “Paper Settings”, Network and System
Settings Guide.

• p.36 "Configuring the Options"

Printing on Both Sides of Sheets (Duplex Printing)

Use the following procedure to specify printing on both sides of each page using the printer driver.

• Duplex printing is not possible if the following paper types are specified:

• Translucent, OHP Transparency, Tab Stock, Label, Back Copied Paper

1. After creating a document, click [Print...] on the [File] menu of the document's native
application.

The [Print] dialog box appears.

2. Select the icon for this printer, and then click [Preferences].

The [Printing Preferences] dialog box appears.

3. Click [Properties...].

The printing preferences properties dialog box appears.

4. Click [Edit] in the menu list.

5. In the [Duplex/Booklet:] list, select a page binding pattern.

6. Change any other settings if necessary.
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7. Click [OK].

The [Printing Preferences] dialog box reappears.

8. Click [OK].

9. Click [Print].

• If the document contains pages with different original sizes, page breaks may occur.

Types of duplex printing

This section explains the binding patterns that are available when the duplex printing function is applied.
When using the duplex printing function, you can select whether to bind copies along their edge or through
their center line.

Edge Binding

• Duplex-Flip on Long Edge (Portrait)

BMF006S

• Duplex-Flip on Short Edge (Portrait)

BMF008S

• Duplex-Flip on Long Edge (Landscape)
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BTG004S

• Duplex-Flip on Short Edge (Landscape)

BTG003S

Center Binding

When PCL5e is specified as the page description language, you must select the [Spool data in EMF
format] check box under the [Advanced] in the menu list.

• Booklet-Open to Left (Portrait)

BMF011S

• Booklet-Open to Right (Portrait)
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BMF012S

• Booklet-Open to Top (Landscape)

BMF017S

• If you want to use the staple or punch function in combination with duplex printing, you must specify
a staple or punch position that is compatible with the binding pattern and duplex position you have
specified.

• When PCL5e is specified as the page description language, you cannot select [Booklet-Open to
Right].

Stapling Printed Sheets

This section explains how to staple output sheets using the printer driver.

With the optional finisher or optional booklet finisher installed, this printer can staple individual sets when
printing multiple sets.

• When using this function, make sure that the printer's option settings are correct. For details about
option settings, see "Configuring the Options".

• Listed below are the types of paper that this printer cannot staple. When using the staple function, use
paper other than the following:

• Thin Paper, Thick Paper 2, Thick Paper 3, Translucent Paper, OHP (Transparency), Label Paper
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1. After creating a document, click [Print...] on the [File] menu.

The [Print] dialog box appears.

2. Select the icon for this printer, and then click [Preferences].

The [Printing Preferences] dialog box appears.

3. Click [Properties...].

The printing preferences properties dialog box appears.

4. Click [Finishing] in the menu list.

5. Select the staple position in the [Staple:] list.

To specify a range of pages to be stapled, select [Page Range Settings...] in the [Setup] menu list.

6. Change other settings as required.

7. Click [OK].

The [Printing Preferences] dialog box reappears.

8. Click [OK].

9. Click [Print].

• If you are specifying a range of pages to be stapled, make sure PostScript is selected as the printer
language. If any other printer language is selected, the staple range setting will not be applied. For
details about [Page Range Settings...], see the printer driver Help.

• Depending on the application, print settings may not be enabled and printed output may not be as
expected.

• When setting staple in the printer driver, make sure that the Collate check box is cleared in the
application's [Print] dialog box. If collate is enabled in the application, printing will not be as intended.

• p.36 "Configuring the Options"

Staple position

The specified staple position varies depending on paper size, type, quantity and feed orientation. The
following table shows staple positions:
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BTG050S

*1 If you are printing using the command instead of the printer driver, be sure to specify the appropriate setting for
rotating the document by 180 degrees with the PJL command.

• If you want to use the staple function in combination with duplex printing, you must specify a staple
position that is compatible with the binding pattern and duplex position you have specified.

• If you want to use the staple function in combination with letterhead printing, you must specify a staple
position that is compatible with the binding pattern and paper orientation you have specified.

• When center staple is set, the fore edge of prints can be cut using the optional trimmer. For details
about cutting the fore edges of prints, see the printer driver Help.

• Empty the trimmer tray if prints are ejected with waste paper stuck to them. For details, see "Removing
Waste Paper", Troubleshooting.

• For paper sizes and maximum number of sheets available for stapling, see "Appendix", About This
Machine.

Stapling precautions

• Stapling can be done only with the optional finisher or optional booklet finisher attached.

Staple printing will be canceled if any of the following occur:

• If the number of pages to staple exceeds maximum.

• If a paper size that cannot be stapled is selected.

• If a paper type that cannot be stapled is selected.

• If multiple copies are specified but collate is not set.

• If positions other than those fixed for stapling are specified.
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• When fold (except Z-fold) and staple are specified at the same time.

• When staples have run out and [When Staple Errors Occur] is set to [Continue Printing], printing
will continue without stapling.

• If the size of the paper after it is Z-folded is not supported for stapling.

• When only 1 page is printed.

• When the required conditions for collate are not fulfilled.

• When the storage area for sort printing has overflowed while printing the job.

• If multiple paper sizes are specified for the document.

• If staple or job separation is selected with the optional finisher or optional booklet finisher installed,
paper will be output to the finisher shift tray with job separation. If an output tray that cannot perform
job separation is specified, paper will be output to that tray without job separation.

• Depending on the application you are using, print settings may not be stored and the printed result
may not be as expected.

• When setting staple in the printer driver, make sure that collate option is not selected in the print settings
of the application. If a collate option is selected in the application, printing will not be as intended.

• When printing restarts after removing jammed paper, the printing position may be different,
depending on the location of the jam.

• If the paper jam occurred in the optional finisher or optional booklet finisher, printing will restart
from the top page of the data currently being printed, or from the page where the paper jam
occurred.

• If the paper jam occurred in the printer, printing will restart from the page where the paper jam
occurred.

• Even if the paper jam occurred in the printer, the error will not be cleared unless the cover of the
finisher is opened and closed.

• For details about specifications for optional finishers, see "Appendix", About This Machine.

• To remove paper misfeeds, see "Clearing Misfeeds", Troubleshooting.

Using Profiles

This section explains how to register and use Profiles.

Each function explained in this section is preconfigured and registered under [Profiles:] in the printing
preferences properties dialog box.

You can apply the relevant setting simply by clicking on the profile name. This helps to avoid incorrect
settings and misprints.

Frequently Used Print Methods

53

2



Profiles can be added, modified, and deleted as required. They can also be shared for use by different
users. By using registered Profiles, users without in-depth knowledge of the printer driver can utilize
advanced printing functions easily.

For details about registering, modifying, and deleting Profiles, see the printer driver Help.
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Advanced Printing
This section explains the printer's advanced printing functions.

In addition to the [Setup] menu in the printing preferences properties dialog box, the [Edit], [Finishing],
[Job Options], [Separators], [Watermarks], and [Advanced] menus also allow you to change print settings.
By clicking on these menus, you can change the following settings.

• For details about printing methods, see the printer driver Help.

Settings That Can Be Changed on Each Menu

Following is an overview of the settings that are available on the [Setup], [Edit], [Finishing], [Job Options],
[Separators], [Watermarks], and [Advanced] menus.

[Setup] menu

You can enable/disable the collate function.

• Collate

When printing multiple sets of documents such as handouts for meetings, you can have prints
delivered in batches of ordered sets. For details about this function, see "Collate".

[Edit] menu

You can enable/disable the layout function.

• Layout:

The combine printing function allows you to economize on paper by printing multiple sheets at
reduced size onto a single sheet. For details about this function, see "Combining Multiple Pages
into Single Page".

[Finishing] menu

You can enable/disable the punch and fold function.

• Punch:

With the optional finisher or optional booklet finisher and optional punch unit are attached, holes
can be punched into printed sheets. For details about this function, see "Punch".

• Fold:

If the optional multi-folding unit and finisher or optional booklet finisher are attached, a variety
of folds can be applied to printed sheets. For details about this function, see "Fold".

[Separators] menu

You can enable/disable the Print Banner, Insert Separation Sheet, Insert Front Cover, Insert Back
Cover, Insert Slip Sheet, Insert Extra Pages, and the Replace Sheets function.
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• Print Banner:

You can print banner pages on sheets fed from a specified paper tray. For details about this
function, see “Printing Banner Pages”.

• Insert Separation Sheet:

You can set separation sheets in the specified paper tray to be inserted between print jobs. For
details about this function, see “Inserting Separation Sheet”.

• Insert Front/Back Cover:

You can insert a front and back cover sheet before and after the document pages. For details
about this function, see “Inserting Front/Back Covers”.

• Insert Slip Sheet:

You can insert a slip sheet between each page. For details, see "Inserting Slip Sheet".

• Insert Extra Pages

You can insert a blank page before a specified page so that when duplex printing is applied,
the page is printed on the front side. For details about this function, see “Inserting Extra Pages”.

• Replace Sheets

You can substitute a specified sheet in the original document with a replacement fed from a
designated tray. For details about this function, see “Replace Sheets”.

[Watermarks] menu

You can enable/disable the Watermark function.

The Watermark function prints text under the main content of every page of a document. For details
about this function, see “Watermarks”.

[Advanced] menu

You can change various settings for other print options.

• Various print functions can be selected in the printer driver. For details about the functions not explained
in this section, see the printer driver Help.

• p.57 "Collate "

• p.57 "Combining Multiple Pages into Single Page"

• p.60 "Punch"

• p.62 "Fold"

• p.65 "Printing Banner Pages"

• p.66 "Inserting Separation Sheet"

• p.66 "Inserting Front/Back Covers"

• p.67 "Inserting Slip Sheet"
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• p.68 "Inserting Extra Pages"

• p.69 "Replace Sheets"

• p.70 "Watermarks"

Collate 

When printing multiple copies of a document such as handouts for meetings, you can separate sets into
order. This function is known as "Collate". Collate stores data transmitted from a computer to the printer's
memory or hard disk drive. The followings are the two types of Collate:

• When setting collate in the printer driver settings, make sure that collate option is not selected in the
application's print settings. If collate option is selected, printing will not be as intended.

Collate Types

• Collate

Printed output is assembled as sets in sequential order.

BAC016S

• Job Separation

The optional finisher or optional booklet finisher is required for this function.

BAC018S

The finisher shift tray moves backward or forward when a job or set is output, causing the next
to shift, so you can separate them.

Combining Multiple Pages into Single Page

This section explains how to print multiple pages onto a single sheet.
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The combine printing function allows you to economize on paper by printing multiple pages at reduced
size onto a single sheet.

Three patterns are available for printing two pages per sheet, and four patterns are available for printing
four or more pages per sheet.

For details about printing method, see the printer driver Help.

• Layout cannot be manually specified if PCL5e is selected as the page description language. Change
the printer description language to PCLXL or PostScript, and then specify the layout.

2 Pages per Sheet

BMF018S

BMF023S

BMF024S
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4 Pages per Sheet

BMF019S

BMF020S

BMF021S

BMF022S
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• When printing on paper that is the same size as the original, if one page in the document is of a
different size to that of the preceding page, a page break will be inserted before the different size
page.

Punch

With the optional finisher or optional booklet finisher and optional punch unit attached, holes can be
punched into printed outputs.

• When using this function, make sure that the settings for the installed options and loaded paper are
correctly configured. For details about configuring the options, see "Configuring the Options".

• For details about printing method, see the printer driver Help.

• p.36 "Configuring the Options"

Punch position

The specified punch position varies depending on paper feed and print data orientation. The following
table shows punch positions:

BTG051S

*1 If you are printing using the command instead of the printer driver, be sure to specify the appropriate setting for
rotating the document by 180 degrees with the PJL command.
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BTG052S

*1 If you are printing using the command instead of the printer driver, be sure to specify the appropriate setting for
rotating the document by 180 degrees with the PJL command.

• If you want to use the punch function in combination with duplex printing, you must specify a punch
position that is compatible with the binding pattern and duplex position you have specified.

• If you want to use the punch function in combination with letterhead printing, you must specify a punch
position that is compatible with the binding pattern and paper orientation you have specified.

• Punch positions will vary slightly from page to page as holes are punched into each sheet individually.

• If two or more paper sizes are specified for the document, the punch position might differ from that
shown in the table.

• The number of holes that can be punched varies according to country.

• For details about paper sizes that can be punched, see "Appendix", About This Machine.

• For details about printing methods, see the printer driver Help.

Punching precautions

Follow these precautions when using the punch function.

• To use this function, the optional finisher or optional booklet finisher must be attached to the printer.

• The punch function is not available on the 135 ppm model with the optional finisher attached.

Punch printing will be canceled under the following conditions:

• When a paper type that cannot be punched is selected.

• When a paper size that cannot be punched is selected.

• When combined with fold function.
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• If positions other than those fixed for punching are specified.

• When duplex print is selected, adjust the punch position to the binding direction.

• Be sure to set the punch position as same as the staple position when using it with the staple function.

• Depending on the application, print settings may not be enabled and printed output may not be as
expected.

• When setting punch in the printer driver settings, make sure that a collate option is not selected in the
print settings of the application. If a collate option is selected in the application, printing will not be
as intended.

• When printing restarts after removing jammed paper, the printing position may be different,
depending on the location of the jam.

• If the paper jam occurred in the optional finisher or optional booklet finisher, printing will restart
from the top page of the data currently being printed, or from the page where the paper jam
occurred.

• If the paper jam occurred in the printer, printing will restart from the page where the paper jam
occurred.

• Even if the paper jam occurred in the printer, the error will not be cleared unless the cover of the
optional finisher or optional booklet finisher is opened and closed.

• For details about specifications for optional finishers, see "Appendix", About This Machine.

• To remove paper misfeeds, see "Clearing Misfeeds", Troubleshooting.

Fold

You can fold prints when the optional multi-folding unit and the optional finisher or optional booklet finisher
are attached to the printer.

Folding positions

The following table shows the folds that this printer can apply to prints.

2. Printing Documents

62

2



BTG053S

*1 To have prints delivered in this format, you must select [Rotate by 180 degrees] and specify the appropriate
fold pattern.

*2 To have prints delivered in this format, you must select [Eject Face-up] and specify the appropriate fold pattern.

*3 To have prints delivered in this format, you must select both [Rotate by 180 degrees] and [Eject Face-up] and
specify the appropriate fold pattern.

*4 If you are printing using the command instead of the printer driver, be sure to specify the appropriate setting for
rotating the document by 180 degrees with the PJL command.

• Gate-fold and multi-sheet fold cannot be applied to coated paper.

• With some applications, the fold direction of the output might be the opposite of the specified direction
when landscape is selected for the Print data direction.

• If two or more paper sizes are specified for the document, the format of the Z-fold might differ from
that shown in the table.

• For details about which sizes and types of paper are compatible with which fold or multifold, see
"Appendix", About This Machine.
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• Paper will not be output to a paper folding tray unless paper folding is specified. If a paper folding
tray is specified as the output tray, but paper folding is not specified, it will be output to the finisher
shift tray.

Notes on the fold function

Follow these precautions when using the fold function.

Folding will be canceled under the following conditions:

• When a paper type that cannot be folded is selected *1

• When a paper size that cannot be folded is selected

• When the combination of the specified paper orientation and folding direction define an
impossible fold.

• When multifold is specified but the number of sheets exceeds the maximum number available
for the multifold function

• If you apply the staple function in combination with half fold, letter fold-in, letter fold-out, double
parallel fold, or gate fold

• When the paper is fed from the optional interposer tray

*1 The fold function is not supported for Thin Paper, Middle Thick Paper, Thick Paper1, Thick Paper 2, Thick
Paper 3, Letterhead, Translucent Paper, OHP(Transparency), Cardstock, Label Paper, and Tab Stock.

When the following functions are set while folding output, the job is reset:

• Staple *1

• Punch

*1 Can be selected with Z-fold, but not in conjunction with booklet staple. Z-fold functions except booklet
staple can be used together.

Restrictions on Z-folding

• If the first page of a print job meets one of the conditions listed below, the job will be automatically
rotated by 180 degrees. (When printing a landscape-direction job, do not specify [Rotate by
180 Degrees].)

Printing conditions

• paper orientation: LEF; print direction: Portrait; staple: Right top/Right 2

• paper orientation: SEF; print direction: Landscape; staple: Left top/Left 2/Left top slant

• Print jobs that contain a mixture of portrait- and landscape-print direction pages are
output as follows when Z-fold is applied:

• When [Rotate by 180 Degrees] is not specified

Portrait pages: lower portion of the page will be folded

Landscape pages: left side of the page will be folded

• When [Rotate by 180 Degrees] is specified
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Portrait-oriented pages: upper portion of the page will be folded

Landscape-oriented pages: right side of the page will be folded

• Depending on the environment in which the printer is used and the type of paper it is printing on, the
fold function can cause toner smearing and dirtying of the printed surface.

• To use the Z-fold function, you must set the Z-fold support tray. For details about how to set the Z-fold
support tray, see "When Folded Paper Is Not Properly Aligned", Troubleshooting.

• Folded prints that are delivered to the folding unit tray may be stacked with their folds open. If this
happens, the position of the folds is unaffected and the prints will still be output in sequential order.
Stacked prints can be easily separated in the order they were delivered. To prevent their folded
sections overlapping, configure the printer to deliver folded prints to the finisher upper tray or finisher
shift tray.

• Remove the Z-fold support tray when delivering prints to the shift tray without using the Z-fold function.
If you leave the Z-fold support tray in place, prints are not stacked properly.

• When stapling Z-folded paper, fewer sheets than normal can be stapled together. This is because a
single Z-folded sheet is equivalent to 10 non-Z-folded sheets.

Printing Banner Pages

You can print banner pages on sheets fed from a specified paper tray.

A banner page contains pre-specified information and is inserted before the main sheets of a print job. The
banner page reports the time the print job was sent and the information entered in the [User Name:], and
[Note:] text boxes in the [Job Information] area.

BRT018S

• If [Spool data in EMF format] is selected in the [Advanced] menu, or the [Page Range Settings] is set
in the [Job Options] menu, a banner page cannot be printed.

• For details about how to print documents, see the printer driver Help.

• This setting is not available if the [Page Range Printing] check box has been selected in the [Job
Options] menu.
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Inserting Separation Sheet

Separation sheets can be inserted between different print jobs.

• This setting is not available if the [Page Range Printing] check box has been selected in the [Job
Options] menu.

• Punch holes are made only in the main pages and not in the separation sheets.

• If the separation sheet function and the shift collate function are both specified, the sheets will be shift
collated before the separation sheets are inserted.

• For details, see the printer driver Help.

Inserting Front/Back Covers

Using this function, you can insert cover sheet fed from a different tray to that of the main paper, and print
on them.

• To use this function, [Collate] must be set.

Front Cover

• When printing one side

BAC023S

• When printing both sides

BAC027S

Back Cover

• When printing one side
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BTG014S

• When printing both sides

BTG015S

• If booklet binding is selected for [Duplex/Booklet:] in the [Edit] menu list, any settings for the back
cover become invalid.

• If the [Collate] check box is not selected, any settings for the front and back covers become invalid
even if multiple copies are specified for [Copies:] in the [Setup] menu.

• This setting is not available if the [Page Range Printing] check box has been selected in the [Job
Options] menu.

• For printing methods, see the printer driver Help.

Inserting Slip Sheet

A slip sheet can be inserted between each page.

Inserting a slip sheet between each page

• Print

BAC024S

• Blank

Advanced Printing

67

2



BAC019S

Inserting a slip sheet between OHP transparencies

• Print

BRS013S

• Blank

BRS014S

• If booklet binding is selected for [Duplex/Booklet:] in the [Edit] menu list, any settings for sheet insertion
become invalid.

• If the [Collate] check box is not selected, any settings for sheet insertion become invalid, even if multiple
copies are specified for [Copies:] in the [Setup] menu list.

• The slip sheet should be the same size and orientation as the body paper.

Inserting Extra Pages

You can insert a sheet after a specified page. For chapter breaks, you can insert a blank page before a
specified page, so that when duplex printing is set, the specified page will be printed on the front side of
the page.
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BTE054S

• Using the printer driver, you can insert up to 100 extra pages within a job.

• When the [Spool data in EMF format] check box has been selected in the [Advanced] menu, or
booklet printing has been set, this function cannot be selected.

• When PCL5e is specified as the page description language, this function cannot be selected.

• For details, see the printer driver Help.

Replace Sheets

You can substitute a specified sheet in the original document with a replacement fed from a designated
tray.

Document content will not be printed on the specified pages.

BTG006S

• By specifying the [Replace Sheets] setting in the printer driver, you can substitute the sheets in up to
18 to 35 locations within a document.

• If the [Spool data in EMF format] check box is selected in the [Advanced] menu, or booklet printing
is set, this function cannot be selected.

• For details about how to print documents, see the printer driver Help.
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Watermarks

You can print text watermarks under the main content of every page of a document.

The following watermarks are pre-registered in the printer driver:

• COPY

BMU900S

• CONFIDENTIAL

BMU902S

• DRAFT

BMU903S

• Other than the pre-registered watermarks, you can create and use your own watermarks.

• For details about how to create, edit, and print original watermarks, see the printer driver Help.
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Spool Printing

Spool printing allows print jobs transferred from a computer to be temporarily stored, and then prints them
after they are transferred. This shortens printing time as it maximizes printer efficiency.

• During spool printing, the hard disk is accessed and the Data In indicator blinks. Turning off the
computer or printer during spool printing can damage the hard disk. Also, if the computer or printer
is turned off during spool printing, spooled jobs will be deleted. Therefore, do not turn the power of
the computer or printer off during spool printing.

• If data is sent to the printer using other protocols besides "diprint" and "lpr", spool printing cannot be
performed.

Setting spool printing

Spool printing can be set using telnet or Web Interface.

• Using Web Interface

For details, see Network and System Settings Guide or Help for more information.

• Using telnet

Type in "spoolsw spool on" to set spool printing.

For details, see Network and System Settings Guide for more information about telnet.

Viewing/Deleting spool jobs in Web Interface

1. Start the Web browser and enter the printer's IP address in the address bar. This displays the top
page.

2. Click [Configurations/Jobs], and then confirm the print jobs in [Current/Waiting Job List].

• Printing the first page with spool printing will be slow.

• The computer requires less print processing time when large amounts of data are spooled.

• Stored spool jobs can be viewed or deleted using Web Interface.
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If Paper Size, Type, and Color Errors Occur
This section gives instructions for operating the printer when there is no tray for the selected paper size,
type, and color, or when paper loaded in the printer has run out.

If there is no tray matching the specified paper size, type, or color, or if the paper loaded in the

printer has run out, a warning message might appear on the control panel.

Follow the instructions displayed on the control panel to load paper in the tray, or [Job Reset] to cancel
printing.

To resume printing, load the paper according to the instructions in the error message. Wait until the error
message disappears automatically, and then press [Online].

• If you have specified a source tray with banner page, separation sheet insertion, front cover sheet,
back cover sheet, slip sheet, or extra sheet insertion, and selected PostScript as the page description
language in the printer driver, the paper loaded in the specified source tray will be printed on. This
will happen even if the paper size specified in the driver does not match the size of the paper loaded
in the source tray. Similarly, any paper type and color settings specified in the driver will also be
ignored.

• If the printer is shared by multiple computers, be careful not to accidentally cancel someone else's
print jobs.
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Sample Print
Use this function to print only the first set of a multiple-set print job.

When this function is enabled, the printer driver prints only the first set of a multiple-set print job. After you
have checked the result, you can decide whether to continue printing or cancel the job.

Note that only the administrator can specify the Sample Print function.

• You can apply the Sample Print function only if collate is specified for the print job.

Enabling Sample Print

This procedure can only be performed by the administrator.

1. Press the [User Tools] key.

BTH002S

2. Press [Printer Features].

3. Press [Administrator Configuration].

4. Press [Printer Settings].

5. If the screen for entering password appears, enter the password for printer settings, and
then press [OK].
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6. Press [Sample Print].

7. Press [Active], and then press [OK].

8. Press the [User Tools] key.

The screen returns to the initial display.

Printing a Sample Print Job

Use the following procedure to specify a Sample Print job using the printer driver.

1. Start printing from the [Print] dialog box of your document's native application.

The Sample Print job is sent to the printer, and the first set is printed.

2. Check the result, and if you are satisfied with it, press [Continue].

The remaining sets are printed.

• To cancel printing after the first set, press [Stop].

• If you cancel printing, the job is deleted.
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Print Using a Registered Form (PCL Macro)
This section explains the PCL macro function.

When printing a document, a form data that has been registered on the printer can be overlaid on the
document.

Any form data created using a Windows application can be registered on the printer using the printer
driver.

If you are using the printer driver to print a document, you must specify the macro you want to overlay onto
the document.

This function is available with the PCL5e only.

Creating Macro

Use the following procedure to create a form data (PCL macro) using the printer driver.

• This function is available with the PCL5e only. Make sure that PCL5e is selected as the page description
language in the printer driver. For details about how to change the page description language or
configure a virtual printer, see “Switching Page Description Language” or “Activating the Printer
Monitor”.

1. Create the form data using any Windows application.

2. On the [File] menu, select [Print].

3. Select the icon for this printer, and then click [Details].

4. Click [Properties...].

The printing preferences properties dialog box appears.

5. Click [Job Options] in the menu list.

6. Select [PCL Macro] in the [Output to:] pop-up menu.

7. Confirm that [None] is selected in [Available Macros:].

8. Click [OK].

9. Click [OK].

10. Click [Print].

11. Enter a name for the macro, and then click [Save].

• p.37 "Switching the Page Description Language"

• p.37 " Activating the Printer Monitor"
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Registering a Form

Use the following procedure to register a form data (PCL macro) that you have created on the printer or
your computer.

1. On the [Start] menu, click [Control Panel], and then click [Printers and Faxes] in the [Printers
and Other Hardware] category.

The [Printers and Faxes] window appears.

2. Select the icon for this printer, and then click [Properties] on the [File] menu.

The printer properties dialog box appears.

3. Click the [Device Settings] tab, and then click [Settings...] in the [Accessories] area.

4. Click [Advanced Options] in the menu list, and then click [Macro Installer...].

5. Click [Install Macros...].

6. Click [Browse...], and then specify a location for the macro.

A list of available form data is displayed in [Available macros:].

7. Select the macro you want to add in the [Available macros:] list.

8. In the [Install macro to] area, select a saving location for the registered macro.

If you select [Host Directory], the macro will be stored on your computer.

If you select [Printer Disk], the macro will be stored on the printer's hard disk drive.

9. Click [Install].

The [Macro Information] dialog box appears.

10. Enter a name for the macro, and then click [OK].

11. Click [OK].

12. Click [Close].

Make sure that the registered macro is displayed in the [Installed Macros:] list.

To change the name of the macro, click [Edit Macro...].

13. Click [Close].

14. Click [OK].

15. Click [OK].

Printing with a Registered Form

Use the following procedure to register a created form data (PCL macro) on the printer or your computer.

2. Printing Documents
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• This function is available with the PCL5e only. Make sure that PCL5e is selected as the page description
language in the printer driver. For details about how to change the page description language, or
configure a virtual printer, see “Switching the Page Description Language” or “Activating the Printer
Monitor”.

• To print a document using a registered form data, you must specify the same print settings as were
specified when the form data was created.

1. After creating a document, click [Print] on the [File] menu of the document's native
application.

The [Print] dialog box appears.

2. Select the icon for this printer, and then click [Preferences].

The [Printing Preferences] dialog box appears.

3. Click [Properties...].

The printing preferences properties dialog box appears.

4. Click [Job Options] in the menu list.

5. Select [Normal Print] on the [Output to:] pop-up menu.

6. Select the macro you want to use in the [Available Macros:] list.

7. Click [OK].

8. Click [OK].

9. Click [Print].

• p.37 "Switching the Page Description Language"

• p.37 " Activating the Printer Monitor"
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3. Using the Control Panel
This chapter explains how to use the normal screen and the print screen to perform operations such as
changing tray settings and browsing the printer information.

Normal Screen
This section explains the items of normal screen that is displayed on the printer’s control panel.

• If you make a setting when the printer is offline, the printer will remain offline afterwards.

• The function items displayed serve as selector keys. You can select or specify an item by pressing it
lightly.

• When you select or specify an item on the control panel, it becomes highlighted.

• Keys dimmed (for example, ) cannot be used.

• If “0” is set as the password for printer settings, entering password is not required to change the printer
settings. To prevent unauthorized changes of the printer settings, we recommend the administrator to
set a password. For the instruction on how to set the password, see “Setting the Password”.

BTG058S

1. Operational status or messages

Displays current printer status, such as "Ready", "Offline", and "Printing...".

2. [ Online] / [ Offline]

Press to switch the printer between online and offline.

When the printer is online, it can receive data from the computer.

When the printer is offline, it cannot print data from the computer.

3. [Program Tray Paper Settings]

Use this to register the paper settings for the currently selected paper tray as a Tray Paper Setting.

If the printer settings are password-protected and Menu Protect is enabled, you must enter the password for
printer settings to configure these settings.
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4. [Recall / Change Tray Paper Settings]

Use this to change the Tray Paper Setting applied to each paper tray using a registration number for each setting.
You can also use this to change the paper size, type, thickness, and color specified for each setting.

If the printer settings are password-protected and Menu Protect is enabled, you must enter the password for
printer settings to configure these settings.

5. [Printer Info]

Displays information about this printer such as its version and serial number, and printer's IP address.

6. [Print Check Sample]

Prints a duplicate of the page being processed and delivers it the proof tray. If duplex printing is specified for the
job, two pages are printed. Otherwise, only one page is printed.

If the printer settings are password-protected and Menu Protect is enabled, you must enter the password for
printer settings to use this function.

7. Print Quantity

Displays the number of copies being printed and the total number of copies specified for the current job.

8. Paper Tray Status

Specify the tray whose paper settings you want to register.

9. [Paper Color Settings] ([Paper Colour Settings])

Use this to specify the color of the paper loaded in each paper tray.

If the printer settings are password-protected and Menu Protect is enabled, you must enter the password for
printer settings to use this function.

10. [Adjust Print Position]

Adjusts the print position vertically and horizontally.

If the printer settings are password-protected and Menu Protect is enabled, you must enter the password for
printer settings to use this function.

11. [Current / Waiting Job List]

Displays a list of the jobs that are currently being processed or waiting in the print queue.

• p.113 "Setting the Password"

Registering Tray-Specific Paper Settings

This section explains how to use the Tray Paper Setting function.

Paper related settings such as size, type, thickness, color, and print position can be registered as a preset
that you can apply by pressing a button. By registering a Tray Paper Setting, you can change the paper
setting for a paper tray simply by selecting the preset number.

Up to 16 presets can be registered to each tray.

3. Using the Control Panel
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• If the optional LCT is installed, to change the paper size setting for tray 4 through 6, specify the paper
size that matches the paper size selected by the paper size selector inside the paper tray. For details
about how to change the paper size, see “Adding Paper”, About This Machine.

• If you want to use Prepunched or Back Copied Paper, contact your service representative.

Registering the current configuration as a Tray Paper Setting

Use the following procedure to register the current configuration of a selected paper tray as a Tray Paper
Setting and assign a preset number to the configuration.

If the printer settings are password-protected and Menu Protect is enabled, you must enter the password
for printer settings to configure this setting.

1. Press the [Printer] key to display the normal screen.

BTG008S

2. Select the tray whose current configuration you want to register as a Tray Paper Setting.

3. Press [Program Tray Paper Settings].

4. If a message prompting you to enter a password appears, enter the password for printer
settings, and then press [OK].

5. Select the registration number for the settings you have registered.

6. Press [OK].

The screen returns to the initial display.

Applying/Reconfiguring a Tray Paper Setting

Use the following procedure to change or recall a registered Tray Paper Setting.

If the printer settings are password-protected and Menu Protect is enabled, you must enter the password
for printer settings to configure these settings.

Normal Screen
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1. Press the [Printer] key to display the normal screen.

BTG008S

2. Press [Recall / Change Tray Paper Settings].

3. If a message prompting you to enter a password appears, enter the password for printer
settings, and then press [OK].

4. Select the tray whose Tray Paper Setting you want to reconfigure or apply.

5. Select the registration number of the Tray Paper Setting that you want to apply or
reconfigure.

To apply settings registered under a specified registration number to a selected tray, proceed to Step
9.

To reconfigure settings registered under a specified registration number, proceed to Step 6.

6. Press [Change Paper Settings].

7. Change the relevant setting(s).

8. Press [OK].

9. Press [OK].

The screen returns to the initial display.

Changing the Paper Color Name

Use the following procedure to program and use the paper color function.

Using this function, you can specify a name for the color of the paper loaded in the source paper tray. If
you register a name for the paper color, that name will be displayed on the control panel with the other
paper tray information.

You can select a color name from one of the seven preset names or specify a custom color name.

If the printer settings are password-protected and Menu Protect is enabled, you must enter the password
for printer settings to configure these settings.

3. Using the Control Panel
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1. Press the [Printer] key to display the normal screen.
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2. Press [Paper Colour Settings].

3. If a message prompting you to enter a password appears, enter the password for printer
settings, and then press [OK].

4. Select the tray containing the paper whose color name you want to register.

5. Select a name for the color from [Colour 1] to [Colour 80].

If the color name you require is not displayed, press [ Previous] or [ Next] to scroll through the list.

6. Press [Change Colour Name].

7. Enter the name for the color, and then press [OK].

8. Press [OK].

The screen returns to the initial display.

• Custom color names can contain up to 14 characters.

• For details about entering characters, see “Entering Text”, About This Machine.

Adjusting the Print Position

This section explains how to adjust the print position.

You can specify the print position in increments of 0.1 mm (0.01 inch) as a distance in the range of 0.0
mm (0.0 inch) to + 30.0 mm (1.20 inch) from the top, bottom, left, and right edges of the paper.

You can also specify settings for the front and back side of pages separately. If one-sided printing is selected,
the settings for the front side of pages will be applied. If duplex printing is selected, different settings for the
front and back side of pages can be specified.

If the printer settings are password-protected and Menu Protect is enabled, you must enter the password
for printer settings to use this function.

Normal Screen
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1. Press the [Printer] key to display the normal screen.

BTG008S

2. Press [Adjust Print Position].

3. If a message prompting you to enter a password appears, enter the password for printer
settings, and then press [OK].

4. Select the tray containing the paper to which the adjusted print position will be applied.

5. Press [ ], [ ], [ ], and [ ] to adjust the print position relative to the top, bottom, left, and
right edges on both the front and back side of the pages.

6. Press [OK].

The screen returns to the initial display.

Browsing the Printer Information

This section explains the information displayed for each item in [Printer Info].

Press [Printer Info] on the normal print screen to display the information about this printer.

Version / Serial Number

• Version:

Displays the version number of this printer.

• Serial Number:

Displays the serial number of this printer.

Network Information

• Mac Address:

Displays the physical address of this printer.

• IP Address:

Displays the IPv4 address assigned to this printer.

• Subnet Mask:

Displays the IPv4 subnet mask specified on this printer.

3. Using the Control Panel
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• Default Gateway Address:

Displays the IPv4 default gateway address specified on this printer.

• Link-local Address:

Displays the IPv6 link local address assigned to this printer.

• Stateless Address:

Displays up to five IPv6 stateless addresses assigned to this printer.

• Manual Configuration Address:

Displays the IPv6 address that was assigned manually on this printer.

• Default Gateway Address:

Displays the IPv6 default gateway address specified on this printer.

Printing a Check Sample

This section explains the [Print Check Sample] function that is available on the normal screen.

To print a duplicate of the page that is currently being processed and deliver it to the proof tray, press [Print
Check Sample] while the page is still being printed. If the key is pressed when there is no job being printed,
a duplicate of the first page printed next will be delivered to the proof tray.

If duplex printing is specified for the job, two pages are printed. Otherwise, only one page is printed. This
function can also be used when printing the lists that are available on the [Test Print] tab under [Basic
Configuration].

If any of the following functions is selected for the job being processed, the sample print cannot be delivered:

• Fold

• Staple

• Punch

• If a password for printer settings is set, and Menu Protect is enabled, the password for printer settings
is required to change the settings for this item.

Normal Screen
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• If the number of copies to be printed before delivering a sample print is specified in [Auto Print Check
Sample] on the [General Settings] tab under [Basic Configuration], the counter is cleared when [Print
Check Sample] is pressed and a sample print will be output.

Job List

This printer temporarily stores the jobs it receives and then processes them in the order in which they arrived.

Press [Current / Waiting Job List] on the normal screen to display the list of jobs that are either currently
being processed or are queued for processing.

Jobs that are queued or being processed can be canceled if they are not required.

Job List screen

This section explains the items on the Current / Waiting Job List screen.

4

1

2

3
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1. Select All

Selects all jobs displayed on the screen.

2. Clear All

Deselects all selected jobs.

3. Delete

Deletes selected jobs.

4. Delete All Jobs

Deletes all jobs displayed on the screen.

3. Using the Control Panel
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Print Screen
This section explains the items on the print screen that is displayed on the printer’s control panel.

To display the print screen, press [To Print Screen] in [Adjustment Settings for Operators] under the basic
settings.

The following items, in addition to the items available on the normal screen, are available on the print
screen:

1

2

BTG059S

1. [Back to Settings]

Pressing this will return the screen to the [Adjustment Settings for Operators] settings.

2. [Print Finishing Sample]

Press this to select the paper tray for test prints, configure the post-printing finishing process, and make other
settings.

Printing a Finishing Sample

Use the following procedure to print a finishing sample.

1. Press the [User Tools] key.

BTH002S

Print Screen

87

3



2. Press [Adjustment Settings for Operators].

3. Press [To Print Screen].

The print screen appears.

4. Press [Print Finishing Sample].

5. Specify the necessary print settings such as source paper tray and output tray.

6. Press [Start Printing].

3. Using the Control Panel
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Canceling a Print Job
This section explains how to stop a print job that is in progress.

Canceling a Print Job Using the Control Panel

Follow the procedure below to cancel printing using the control panel.

1. Press the [Printer] key.

BTG008S

2. Press [Current / Waiting Job List].

3. Select the job being processed.

4. Press [Delete].

5. Press the [Printer] key.

The screen returns to the initial display.

6. Press [Online].

Canceling a Print Job from the Computer

This section explains how to delete the job currently in process from the computer.

Canceling a Print Job
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You can cancel a print job from the computer if transferring print jobs is not completed.

1. Double-click the printer icon on the Windows task tray.

A window appears, showing all print jobs currently queued for printing. Check the current status of
the job you want to cancel.

2. Select the name of the job you want to cancel.

3. On the [Document] menu, click [Cancel].

4. Press the [Printer] key on the printer's control panel.

• If the printer is shared by multiple computers, be careful not to accidentally cancel someone else's
print jobs.

• You cannot stop printing data that has already been processed. For this reason, printing may continue
for a few pages after you press [Job Reset].

• A print job containing a large volume of data may take considerable time to stop.

3. Using the Control Panel
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4. Printing a PDF File Directly
This chapter explains how to use PDF direct print.

PDF Direct Print Precautions
You can send PDF files directly to the printer for printing, without having to open a PDF application. This
section explains precautions of PDF direct print.

• This function is possible for genuine Adobe PDF files only.

• Version 1.3, 1.4, 1.5, and 1.6 PDF files are compatible.

• PDF files created using PDF version 1.5 Crypt Filter functions or more than eight DeviceN Color Space
components cannot be printed.

• PDF files created using PDF version 1.6 watermark note functions, or extended optional contents
cannot be printed.

• PDF version 1.7 (Acrobat 8.0) files created without any functions that are exclusive to PDF version
1.7 can be printed.

• Paper size errors may occur when printing on custom size paper.
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Using Commands to Print
This section explains how to use PDF direct print.

To send PDF files directly to this printer for printing, use the "lpr" command.

• For details about PDF direct print and the "lpr" command, see “Printing Files Directly from Windows”.

• p.139 "Printing Files Directly from Windows"

Sending a PDF file

Use the following procedure to send a PDF file to this printer using the "lpr" command.

Using the "lpr" command, you can specify the printer’s IP address, the name of the PDF file, and the name
of the virtual printer. The syntax is as follows.

C:\>lpr -S "printer's IP address" –P"virtual printer name" [-ol] \path\file name

• "pdf" is configured and registered as the default virtual printer for PDF direct printing.

Entering the PDF Password

Use the following procedure to print a password protected PDF file directly.

To print a PDF file that is protected by a password, enter the password using the control panel, Web
Interface, or the PJL command. When the password is entered using the PJL command, the password entered
using the control panel or Web Interface is ignored.

Using the PJL command

To enter the password for a password protected PDF file, use the following command and value in
conjunction with the PJL command.

• Command: SET

• Value: PDFPASSWORD

• Example: @PJL SET PDFPASSWORD=the PDF password

Up to 32 ASCII characters (0x20 – 0x7E (Except 0x22)) can be entered as the PDF password.

Using the Control Panel

To enter a PDF password using the control panel, select [PDF Password] on the [PS / PDF Menu] tab
under [Basic Configuration] in the [Printer Features] menu.

4. Printing a PDF File Directly
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Using Web Interface

To enter the PDF password using Web Interface, select the [PS/PDF] menu in [Printer Settings] under
[Configurations/Jobs], and then set [PDF password].

Using Commands to Print
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5. Printer Features
This chapter describes the user tools that are available in the Printer Features menu.

Basic Configuration
User Tools settings can be configured by both general users and the administrator.

• Operations for system settings differ from normal operations. Always close User Tools when you have
finished.

• Any changes you made with User Tools remain in effect even if the main power switch or operation
switch is turned off, or the [Energy Saver] or [Clear Modes] key is pressed.

• If the printer settings are password-protected and Menu Protect is enabled, you must enter the
password for printer settings to configure these settings.

Changing the Default Settings

Use the following procedure to change the User Tools settings.

If Menu Protect is enabled, you must enter the password for printer settings to configure these settings.

1. Press the [User Tools] key.

BTH002S

2. Press [Printer Features].
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3. Press [Basic Configuration].

4. Select the item whose settings you want to change.

5. If a message prompting you to enter a password appears, enter the password for printer
settings, and then press [OK].

6. Change the settings by following the instructions on the display.

7. Press [OK].

8. Press [Exit] to return to the [Printer Features] screen.

Press the [User Tools] key to return to the normal screen.

General Settings

This section explains the items on the [General Settings] tab under [Basic Configuration].

If Menu Protect is enabled, you must enter the password for printer settings to configure these settings.

Resolution

You can specify the printing resolution. This setting is effective only if you are using PostScript, PCLXL,
PCL5e, or printing a PDF document.

The default setting is 600 dpi.

Wait Timeout (Non-PS)

You can specify how long the printer waits for data. A timeout will occur when the time you specify
here elapses.

If you specify "0", the printer will wait indefinitely.

The default setting is 300 second(s).

LPD Job Reception Timing

You can specify how the printer receives and processes jobs transmitted by LPD.

If you select [After Receiving Previous Job], the printer accepts reception requests for subsequent jobs
only when it has finished receiving any earlier jobs.

5. Printer Features
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If you select [Always], the printer accepts reception requests for subsequent jobs while it is still receiving
earlier jobs.

If you select [After Printing Previous Job], the printer accepts reception requests for subsequent jobs
only when it has finished both receiving and printing any earlier jobs.

The default setting is After Receiving Previous Job.

Meth. for Switching between 1&2 Sided Feed

You can specify how the printer processes jobs that contain both one-sided and two-sided pages. If
you select [Speed Priority], the printer automatically inserts a blank sheet when it detects a one-sided
page. This reduces the printing time required for jobs that contain both one- and two-sided pages.

The default setting is Job Settings Priority.

Auto Print Check Sample

This function delivers a sample print to the proof tray each time a specified number of copies is reached
during a print run. The sample print allows you to check for consistent quality during long print runs.
You can specify a number between 0 and 5000 in steps of 500. A sample print will be output each
time the number of copies you specify here is printed.

If you specify "0", no sample print will be output.

The default setting is 0.

The counter is cleared when you change this setting.

Rotate by 180 Degrees

You can have the printer automatically rotate the print image 180 degrees relative to the paper
orientation. This setting is effective only when you are using PostScript, PCLXL, PCL5e, or printing a
PDF document.

The default setting is Inactive.

Face Up

If you select this function, printed sheets will be output printed side facing up. This setting is effective
only when you are using PostScript, PCLXL, PCL5e, or printing a PDF document.

The default setting is Inactive.

Reverse Order Printing

Use this function to print the document in the reverse order of the original (the last page of the document
will be printed first).

The default setting is Inactive.

Job Separation

Use this function to divide print jobs into easily separable batches. This setting is effective only when
you are using PostScript, PCLXL, PCL5e, or printing a PDF document.

The default setting is Inactive.

Basic Configuration
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Auto Tray Switching: Tray Setting

You can specify whether or not to make every tray available as a source tray for the Auto Tray
Switching function. This setting is effective only when you are using PostScript, PCLXL, PCL5e, or
printing a PDF document.

The default setting is Active.

PS / PDF Menu

This section explains the items on the [PS / PDF Menu] tab under [Basic Configuration].

If Menu Protect is enabled, you must enter the password for printer settings to configure these settings.

Print Error Report

You can select whether or not the printer prints an error page whenever a PostScript error occurs. This
setting is effective only when you are using PostScript or printing a PDF document.

The default setting is Active.

Alt. Paper Size with Reduced Print Image

You can specify how the printer processes a document if the paper size selected when the job is sent
is different from the paper size selected on the printer’s control panel.

If you select [Active], the document is printed at reduced size to fit the paper loaded in the printer.

If you select [Inactive], the printer suspends printing and requests a paper change.

The default setting is Active.

Job Timeout

You can specify the maximum time allocated for a single print job. If a job cannot be processed within
this time, a timeout error occurs. If you select “0”, the printer will continue to attempt processing until
manually interrupted. This setting is effective only when you are using PostScript or printing a PDF
document.

The default setting is 0 second (s).

Wait Timeout (PS)

You can specify how long the printer waits for data. A timeout will occur when the time you specify
here elapses. If a timeout occurs, PostScript jobs whose data is incomplete will be canceled. The
timeout settings configured on the [General Settings] tab have priority over the timeout setting for each
job. This setting is effective only when you are using PostScript or printing a PDF document.

If you specify "0", the printer will wait indefinitely.

The default setting is 295 second (s).

5. Printer Features

98

5



Halftone Density

You can specify the density of halftone. When the halftone command is specified for a job, you can
adjust the printout density by changing this setting. This setting is effective only when you are using
PostScript or printing a PDF document.

The default setting is Normal.

Halftone Screen Frequency

You can specify the screen frequency for halftone. This setting is effective only when you are using
PostScript or printing a PDF document.

The screen frequency specified in this setting is applied only when the resolution is set to 600 dpi.

The value is halved when the resolution is set to 300 dpi. For example, if 106 lpi is specified in this
setting, the actual screen frequency generated at 300 dpi will be 53 lpi.

If the resolution is set to 1200 dpi, the screen frequency will be fixed at 141 lpi, regardless of this
setting.

The default setting is 106 lpi.

PDF Password

You can enter the password to be used when printing a PDF file with a password. When using the
PDF direct print function, only documents with a password that matches the password specified here
will be printed.

Switching between 1&2 Sided Print Functions

You can select how the printer handles a document when a paper size specification command is
contained in the data for the front and back side of pages.

If you select [Active], the pages after the size change command is received are printed on the front
sides.

If you select [Inactive], the printer continues to print pages on the back sides of sheets even after the
size change command is received.

The default setting is Active.

• If you enable [Alt.Paper Size with Reduced Print Image], sheets may be fed from the interposer, and
the output might include blank sheets. If this happens, make sure the paper size and orientation for
the print job and the paper settings on the printer are set correctly, and then print the document again.

PCL Menu

This section describes the items on the [PCL Menu] tab under [Basic Configuration].

If Menu Protect is enabled, you must enter the password for printer settings to configure these settings.

Basic Configuration

99

5



Extend A4 Width

You can select whether or not to enlarge the print area of A4 size paper when printing a Letter sized
document on A4 size paper.

The default setting is Inactive.

Tray Switching

You can select how the printer responds if the paper specified for a print job is not loaded in the
specified paper tray.

If you select [On], the printer will feed from another tray that is loaded with the paper of the same
size as the specified paper.

If you select [Off], the printer will stop printing and prompt the user to load paper of the required size
in the tray.

The default setting is Off.

Auto Orientation (Portrait to Landscape)

You can select how the printer responds when the portrait orientation is specified for a job but the
paper tray contains only sheets that are loaded in the landscape orientation.

If you select [Active], printer will rotate the print image by 90 degrees and print it in the landscape
orientation.

If you select [Inactive], the printer will stop printing and prompt the user to change the orientation of
the paper loaded in the tray.

This setting is effective only when the paper size is constant and the paper loaded in the tray is in the
landscape orientation. When landscape is specified for a print job, the paper cannot be fed from a
tray containing paper in the portrait orientation.

The default setting is Inactive.

Test Print

This section describes the items on the [Test Print] tab under [Basic Configuration].

If Menu Protect is enabled, you must enter the password for printer settings to configure these settings.

System / Printer Information List

You can print the system and printer information list.

Configuration Page

You can print a list of the printer settings.

Menu List

You can print a list of available menus.

Printer HDD Usage Status List

You can print the hard disk drive usage information.

5. Printer Features
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Programmed Tray Paper Settings List

You can print a list of the paper types that are registered on the printer.

PS Configuration / Font Page

You can print a list of the PS/font page settings.

PCL Configuration / Font Page

You can print a list of the PCL settings.

Cross Pattern Print

You can print a test pattern for the print position registration.

Raster Pattern Print

You can print a test pattern for the print quality check.

Menu Protect

This section lists the items that are protected by the Menu Protect function.

By enabling Menu Protect, you can limit access to certain settings and functions. You must enter the
password for printer settings to enable this function.

When you enable Menu Protect, the following settings and functions are available only to users who have
the Menu Protect password:

Settings/Functions on the normal screen

• Program Tray Paper Settings

• Recall / Change Tray Paper Settings

• Print Check Sample

• Paper Colour Settings

Functions under Printer Features

• Basic Configuration

(Viewing the current settings is possible without entering the Menu Protect password.)

• To prevent general users from changing the protected menus settings or functions using the Menu
Protect function, be sure to set the password for printer settings. If you set “0” as the password for
printer settings, the Menu Protect function becomes ineffective and the menus will not be protected.

Use the following procedure to enable Menu Protect.
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1. Press the [User Tools] key.

BTH002S

2. Press [Printer Features].

3. Press [Administrator Configuration].

4. Press [Printer Settings].

5. If the screen for entering password appears, enter the password for printer settings, and
then press [OK].

6. Press [Menu Protect].

7. Press [Active], and then press [OK].

8. Press [Exit] to return to the [Printer Features] screen.

9. Press the [User Tools] key to return to the normal screen.
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Administrator Configuration
This section explains how to change the printer's operation, interface, and security settings using the
[Administrator Configuration] menu. Changing the settings on this menu requires the administrator's
permissions.

To change these settings on this menu, the password for printer settings is required.

Changing the Default Settings

Use the following procedure to change the User Tools settings.

To perform this procedure, you must enter the password for printer settings.

1. Press the [User Tools] key.

BTH002S

2. Press [Printer Features].

3. Press [Administrator Configuration].

4. Press [Printer Settings].

5. If a message prompting you to enter a password appears, enter the password for printer
settings.

6. Select the item whose settings you want to change.
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7. Change the settings by following the instructions on the display, and then press [OK].

8. Press [Exit] to return to the [Printer Features] screen.

Press the [User Tools] key to return to the normal screen.

• Only the administrator can change the settings on the [Printer Settings] menu. The [Printer
Management] menu is for use by your service technician. Do not change the settings on this menu.

General Features

This section explains the items on the [General Features] tab under [Administrator Configuration: Printer
Settings].

To change the settings on this menu, you must enter the password for printer settings.

Misfeed Recovery

Select whether or not remaining pages are printed if a job is interrupted due to a paper jam.

The default setting is On (remaining pages are printed).

When PS / PDF Errors Occur

Select the printer's response when it detects a PostScript or PDF error: display an error message and
cancel printing, or continue printing the next job.

The default setting is Continue Printing.

When Staple Errors Occur

Select the printer's response when it runs out of staples: stop printing, or continue printing.

The default setting is Continue Printing.

Sample Print

Select whether or not the printer continues printing after it completes the first set in a multiple set print
run.

If you select [Active], the printer pauses after it finishes the first set. If you press [Continue], it continues
to print the remaining sets. To cancel the print job, press [Stop].

This setting is effective only on jobs for which collate is specified.

The default setting is Inactive (printing continues).

Password for Printer Settings

Specify the password for printer settings by entering a number between 0 and 65535. If you enter
“0”, the password protection will be disabled.

The default setting is 1000.

If you require stronger security, we recommend you change the password from its default setting.
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Auto Backup Time

Specify the time at which the auto backup function becomes active. Backing up of the data on the
controller and hard disk drive begins at the time you specify here.

The default setting is 1:00 (backup begins at 1:00 each day).

The default setting is 1:00 AM (backup begins at 1:00 each day).

PS / PDF Memory Size

Specify the amount of memory allocated for PostScript/PDF usage. A value between 10 and 100MB
can be entered. This setting becomes effective after the printer has been restarted.

The default setting is 40 MB.

PCL Memory Size

Specify the amount of memory allocated for PCL usage. This setting becomes effective after the printer
has been restarted.

The default setting is 40 MB.

Menu Protect

Select whether or not to password-protect the menus on the normal screen and some items under the
printer settings menu.

The default setting is Inactive.

If you select [Active], you must enter the password for printer settings to change the protected items.
However, if you specify "0" for the password for printer settings, the Menu Protect function is disabled
and the items on the printer settings menu will not be protected.

Auto Tray Switch: Switch Timing

Specify how the printer switches between trays when the Auto Tray Select function is set.

If you select [After All Paper is Used], the printer continues to feed from the switched tray until that
tray becomes empty.

If you select [When Paper is Loaded], the printer switches to the tray that has the highest priority as
soon as the paper is reloaded.

The default setting is When Paper is Loaded (the printer switches to the tray that has highest priority).

Auto Tray Switching: Tray Switch Setting

Specify the order in which the printer switches between trays when the Auto Tray Select function is
set.

If you select [Prioritize Priority Tray], the printer always switches to the source paper tray that has the
highest priority.

If you select [Tray Switch Order], the printer feeds from the tray that has the highest priority until that
tray is empty, and then switches to the tray that has the next highest priority.
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The default setting is Prioritize Priority Tray (the printer feeds from the tray that has highest priority).

Interface Settings

This section describes the items on the [Interface Settings] tab under [Administrator Configuration: Printer
Settings].

To change the settings in this menu, you must enter the password for printer settings.

Network

The following settings are available under [Network] on the [Interface Settings] tab.

IPv4

Select whether or not to allow communication over an IPv4 network. If the setting has been changed
from inactive to active, you must restart the printer to apply the new setting.

The default setting is Active (communication over IPv4 is allowed).

IPv4 Address

Specify the printer's IPv4 address.

Subnet Mask

Specify the printer's IPv4 subnet mask.

IPv4 Default Gateway Address

Specify the printer's IPv4 gateway address.

IP Address Setting Method

Specify the method by which the printer obtains its printer's IP address: automatically by DHCP (from
a server), or by manual entry.

The default setting is Specify (manual entry).

This setting becomes effective after the printer has been restarted.

Transmission Speed

Specify the method and speed of transmission. This setting becomes effective after the printer has been
restarted.

Select the speed that matches your network environment. We recommend you select [Auto Select] if
you are unsure of your network's specifications.

The default setting is Auto Select.
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10Mbps
Half Duplex

10Mbps
Full Duplex

100Mbps
Half Duplex

100Mbps
Full Duplex

1Gbps Full
Duplex

Auto Select

10Mbps
Half Duplex

10Mbps
Full Duplex

100Mbps
Half Duplex

100Mbps
Full Duplex

1Gbps Full
Duplex

Auto Select

IPv6

Select whether or not to allow communication over an IPv6 network. If the setting has been changed
from inactive to active, you must restart the printer to apply the new setting.

The default setting is Active (communication over IPv6 is allowed).

IPv6 Address

Select this to browse for the link local address, stateless address (max: 5), and the default gateway
for the IPv6 network.

Manual Configuration Address

Specify the printer's IPv6 address.

Stateless Address Autoconfiguration

You can select whether or not to automatically select the stateless address for the IPv6 network. To
change the setting from “Active” to “Inactive”, restart the printer to make the setting effective.

The default setting is Active (selection is automatic).

HTTP Port Number

Select the port to be used to connect to Web Interface. This setting becomes effective after the printer
has been restarted.

The default setting is 80.

DDNS Configuration

Enable or disable DDNS.

The default setting is Inactive (DDNS is disabled).
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Domain Name

Specify the method by which the printer obtains its domain name: automatically by DNS (from a
server), or by manual entry. If you select manual entry, you must enter the domain name.

The default setting is Specify (manual entry).

DNS Server IPv4 Address

Specify the method by which the printer obtains the DNS server's address: automatically, or by manual
entry.

The default setting is Specify (manual entry).

DNS Server IPv6 Address

You can specify the IPv6 address for the DNS server.

Host Name

Enter a host name for this printer.

Parallel Interface

The following settings are available under [Parallel Interface] on the [Interface Settings] tab.

ACK Response Time

Specify the Ack pulse interval by entering a number between 500 and 12750.

The default setting is 1000 ns.

Mode

Select the mode for the parallel interface.

The default setting is IEEE 1284.

Emulation

Specify the emulation mode and the PostScript data format.

The default setting is Auto.

IEEE 802.1X

The following settings are available under [IEEE 802.1X] on the [Interface Settings] tab.

The changes made on this tab become effective when you change the screen.

The IEEE 802.1X authentication function is not available for a print network.

Although the settings for IEEE 802.1X are displayed on the operation panel and Web Interface, they cannot
be configured. On the printed list of settings, the settings for IEEE 802.1X will always be shown as [Inactive].

EAP-TLS

Select whether to enable or disable EAP-TLS.
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The default setting is Inactive (disabled).

EAP-TTLS (PAP)

Select whether to activate or inactivate EAP-TTLS (PAP).

The default setting is Inactive (disabled).

PEAP (MSCHAPv2)

Select whether to activate or inactivate PEAP (MSCHAPv2).

The default setting is Inactive (disabled).

LEAP

Select whether to enable or disable LEAP.

The default setting is Inactive (disabled).

User Name

Enter a user the name for the IEEE 802.1X wired connection.

Password

Enter a password for the IEEE 802.1X wired connection.

Network Security

This section explains the settings on the [Network Security] tab under [Administrator Configuration: Printer
Settings].

Using this tab, you can select whether the IPv4 and IPv6 ports for each protocol are open (active) or closed
(inactive).

To change the settings in this menu, you must enter the password for printer settings.

DIPRINT

• IPv4 / IPv6

The default setting is Active.

LPR / LPD

• IPv4 / IPv6

The default setting is Active.

HTTP

• IPv4 / IPv6

The default setting is Active.

IPP

• IPv4 / IPv6

The default setting is Inactive.
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IPP (Port 631)

• IPv4 / IPv6

The default setting is Inactive.

SSL / TLS (Port 443)

• IPv4 / IPv6

The default setting is Active.

AppleTalk

The default setting is Active.

SNMP Public Write

The default setting is Inactive.

SNMP

• IPv4 / IPv6

The default setting is Active.

Access Control

This section explains the settings on the [Access Control] tab under [Administrator Configuration: Printer
Settings].

Using this tab, you can limit the IP addresses that are allowed to access the printer to a specified range.
Up to five settings each for IPv4 and IPv6 can be specified.

To change the settings on this menu, you must enter the password for printer settings.

Access Control Range 1-5

• Start Address

Enter the start address of the access control range by entering an IP address between 0.0.0.0
to 255.255.255.254. If you are using this printer in an IPv6 environment, you can enter up to
45 characters (0-9, A-F, a-f, ":" and "."). Note however that Multicast is not available in an IPv6
environment.

• End Address

Enter the end address of the access control range by entering an IP address between 0.0.0.0
to 255.255.255.254. If you are using this printer in an IPv6 environment, you can enter up to
45 characters (0-9, A-F, a-f, ":" and "."). Note however that Multicast is not available in an IPv6
environment.

• Authentication

Select whether to authenticate access attempts from IP addresses within the specified range.

• Mask Value
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Enter the mask value of the IP addresses.

• Mask Length

Specify the mask length of the IP addresses by entering a number between 1 and 128.

IPP Authentication

This section explains the settings on the [IPP Authentication] tab under [Administrator Configuration: Printer
Settings].

Using this tab, you can specify which users have IPP access to the printer.

To change the settings in this menu, you must enter the password for printer settings.

Authentication

Select whether or not authentication is applied. If you chose to apply authentication, you must then
select [BASIC] or [DIGEST] as the authentication method.

The default setting is Inactive (authentication is not applied).

User Name / Password 1-10

Enter the user names and passwords of the users who you want to grant IPP access to. You can enter
the details of up to 10 users.

SSL / TLS

The following setting is available on the [SSL / TLS] tab under [Administrator Configuration: Printer Settings].

You can also configure SSL/TLS on this tab.

To change this setting, you must enter the printer settings password.

Permit SSL / TLS Communication

Select [Ciphertext Priority] or [Ciphertext / Cleartext] as the encryption method.

• You can select [Ciphertext Only] only if the SSL certificate for the printer is already installed on the
printer.

• Only the encryption method can be changed using the control panel. To change any other settings,
use Web Interface. For details, see “Enhancing Printer Security”.

• p.113 "Enhancing Printer Security"

Administrator Configuration

111

5



5. Printer Features

112

5



6. Enhancing Printer Security
This chapter explains the functions that you can apply to enhance the security of this printer.

This printer has various functions that can prevent unauthorized access, usage, changes to settings, and
data copying.

Only the administrator can enable or disable security functions. For details about the functions that can
enhance this printer's security and how to configure them, contact your administrator.

The IEEE 802.1X authentication function is not available for a print network.

Although the settings for IEEE 802.1X are displayed on the operation panel and Web Interface, they cannot
be configured. On the printed list of settings, the settings for IEEE 802.1X will always be shown as [Inactive].

Setting the Password
This printer can be protected by the password for printer settings.

The password for printer settings is for the administrator. If password is set, the user will be prompted to
enter it when s/he attempts to use the printer or access its settings.

We recommend the administrator to set the password for printer settings, as this will protect the printer's
settings from unauthorized changing.

• If the password for printer settings is set to "0", password protection will be disabled. Be sure to set a
value other than "0" if you want to apply password protection.

Setting the Password for Printer Settings

Use the following procedure to change the password for printer setting.

To perform this operation, you must enter the password for printer settings.

1. Press the [User Tools] key.

BTH002S
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2. Press [Printer Features].

3. Press [Administrator Configuration].

4. Press [Printer Settings].

5. If the screen for entering password appears, enter the password for printer settings, and
then press [OK].

6. Press [Password for Printer Settings].

7. Enter the new password, and then press [OK].

8. Re-enter the new password again to confirm it, and then press [OK].

9. Press the [User Tools] key.

The screen returns to the initial display.

• If you forget the password for printer settings, contact your administrator.
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Encrypting IPP Authentication
This section explains how to encrypt IPP authentication.

If you activate IPP authentication, you can control which users can access this printer by IPP. Only users
whose user names and passwords have been registered for IPP access will be able to access this printer
by IPP.

There are two types of IPP authentication.

BASIC

Users whose user names and passwords match those registered on the printer are allowed to print
documents.

With this method, user names and passwords are not encrypted when sent to printer for authentication.

DIGEST

Users whose user names and passwords match those registered on the printer are allowed to print
documents.

With this method, user names and passwords are encrypted when sent to printer for authentication.

To prevent leakage of sensitive data and unauthorized tampering, we recommend you apply DIGEST IPP
authentication.

• For details about how to configure IPP authentication, contact your administrator.

Encrypting IPP Authentication
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Changing the SSL/TLS Encrypted
Communication Mode
This section describes the encrypted communication modes for SSL/TLS.

This printer is capable of encrypted communication using SSL. Encryption by SSL prevents eavesdropping
and unauthorized acquisition of data.

There are various encryption modes of differing security strengths available for SSL/TLS. This printer
supports the following SSL/TLS encryption modes:

Ciphertext Only

Only encrypted data is allowed. Non-encrypted data is refused.

Ciphertext Priority

Data is encrypted if possible. If encryption is not available, data is sent as plain text.

Ciphertext / Cleartext

Data is sent in encrypted or plain text format, depending on the method specified.

• For details about how to configure SSL/TLS, contact your administrator.
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Using User Authentication
This section explains the user authentication function.

User authentication prevents unauthorized users from printing jobs. When this function is enabled, each
time it receives a job, the printer matches the user name and password sent with the job against a record
of registered users. If there is a match, the printer processes the job. If there is no match, the printer does
not process the job.

For details about how to enable the authentication function on this printer, contact your administrator.

Configuring the Printer Driver for User Authentication

Use the following procedure to register a user's authentication information in the printer driver.

1. On the [Start] menu, click [Control Panel], and then click [Printers and Faxes] in the [Printers
and Other Hardware] category.

The [Printers and Faxes] window appears.

2. Select the icon for this printer, and then click [Properties] in the [File] menu.

The printer properties dialog box appears.

3. Click the [Device Settings] tab, and then click [Settings...] in the [Accessories] area.

4. Click the [Advanced Options] menu list.

5. Select [Confirm authentication information when printing].

To encrypt the password also, select [Encrypt] and enter the driver encryption key.

6. Click [OK].

If the [Confirm Driver Encryption Key] dialog box appears, re-enter the same encryption key, and
then click [OK].

The printer properties dialog box reappears.

7. Click the [General] tab, and then click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

8. Click [Properties...].

The printing preferences properties dialog box appears.

9. Click [Job Options] in the menu list.

10. Enter the user's user name and password in the boxes in the [User Authentication] area,
and then click [OK].

If user code authentication is enabled, enter a user code containing up to eight digits in the [User
Authentication] box. A login password is not required if user code authentication is enabled.

11. Re-enter the same password, and then click [OK].
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12. Click [OK] twice.
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7. Using Mac OS X
This chapter explains how to use this printer under Mac OS X.

Installing to the Mac OS X
This section explains how to configure Mac OS X to use EtherTalk and TCP/IP.

This manual assumes that the user has a general knowledge of the functions and operations of Macintosh
computers. For details about the functions of Macintosh computers and how to use them, see manual
provided with your Macintosh or access the relevant online Help.

• Mac OS X 10.5 is required for this machine.

Installing the PPD Files

Follow the procedure below to install a PPD file to print from Mac OS X.

• You need an administrator name and a password (phrase). For details, consult your network
administrator.

1. Insert the CD-ROM into the CD-ROM drive.

2. Double-click the CD-ROM drive icon.

3. Double-click the [Mac OS X] folder.

4. Double-click the installer icon.

5. Follow the instructions on the screen.

Setting Up the PPD File

1. Start Printer Setup Utility.

Start System Preferences and click [Print & FAX].

2. Click [Add] or [ ] button.

Click [Default]. If the printer name is not displayed, select the icon that corresponds to your network
environment (AppleTalk, etc.).

If several AppleTalk zones exist on the network, select the zone the printer belongs to.

3. Select the printer, and then select its manufacturer on the [Printer Model:] pop-up menu.

Select the printer you are using in the [Printer Name] list.
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4. Select the PPD file for the model you are using, and then click [Add].

5. Quit Printer Setup Utility or System Preferences.

Setting Up Options

1. Start System Preferences.

2. Click [Print& Fax].

3. In the [Printer] list, click the name of the printer you want to use, and then click [Printer
Setup...].

4. Select the option you want to set up, and then select an appropriate setting for it.

5. Click [Apply Changes].

• If the option you want to select is not displayed, PPD files may not be set up correctly. To complete
the setup, check the name of the PPD file displayed in the dialog box.
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Paper and Print Settings
This section explains how to display the dialog box where you can change the print and paper settings.

Changing Paper Setups

Use the following procedure to display the dialog box where you can change the paper settings.

1. Open the document that you want to print.

2. Select [Page Setup].

3. Check that this printer is selected in the [Format for:] list, and then change the paper-related
settings as necessary.

If the printer you are using is not selected in the [Printer:] list, click the list and then select the printer.

4. Change any other settings as necessary, and then click [OK].

• If certain combination of staple, punch, and fold are specified, [Orientation] in [Page Setup] must
also be specified. You can specify one of the following three orientations:

BTG054S

1. Portrait

2. Landscape

• The content of the [page setup] dialog box will differ depending on the application or operating
system. For details, see the manual or help files provided with your Macintosh computer.

Browsing Print Setup Information

Use the following procedure to display the dialog box where you can change the print settings.

1. Open the dialog box for changing the print setup information.

2. Open the document that you want to print.

3. Select [Print] on the [File] menu.
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4. Check that this printer is selected in the [Printer:] list, and then change the print-related
settings as necessary.

If the printer you are using is not selected in the [Printer:] list, click the list and then select the printer.

5. To print the document, click [Print].

• The content of the [page setup] dialog box will differ depending on the printer model and the
application your document was created in. For general information about printing documents, see
Macintosh help.

Print Settings

This section explains the functions in the [print setup] dialog box that are specific to this printer.

In the pop-up menu, select the function you wish to configure. [Layout] and [Printer Features] are explained
in this section.

When “Auto Select” is selected in [Paper Feed], and the specified paper size is not loaded in the paper
tray, the document is printed according to the settings specified on the printer.

For general information about setting up and printing documents, see Macintosh help.

Layout

Select [Layout] in the pop-up menu to change the layout-related settings.

• [Pages per Sheet:]

Specify the number of pages to be printed on a single sheet of paper, and then specify the layout
of the pages. You can also specify a border line on individual pages by selecting the [Border:]
pop-up menu.

• [Two Sided Printing]

Select whether to use the duplex print function. The binding direction can also be specified.

Printer Features

Select [Printer Features] in the pop-up menu to change the printer-specified settings.

The settings that are available on this menu will differ depending on the model of your printer and the
options installed on it.

To switch between the printer function screens, click [Feature Sets].

• Auto Tray Switching

Select this to apply the Auto Tray Switching function.

• Resolution

Select the output resolution setting.

• Leading Edge
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Select the orientation in which sheets are fed into the printer.

• Paper Type

Select the paper type to use.

• Paper Color

Select the base color of the paper.

• Image Rotation

Select this to rotate the print image.

• Destination

Select the output tray to which printed sheets are delivered.

• Fold Type

Select the type of fold that you want to apply to output sheets.

• Off

Output sheets are not folded.

• Zfold

Use the following procedure to apply a Z-fold to printed sheets.

• Half Fold

Folds sheets in half along their long edge.

• Letter Fold-in

Folds sheets into thirds with their two end sections folded one on top of the other.

• Letter Fold-out

Folds sheets into thirds with their two end sections folded in opposite directions.

• Double Parallel Fold

Folds sheets in half and then in half again with all folding edges aligned parallel to each
other.

• Gate Fold

Folds sheets into four sections, with their two end sections folded inward.

• Half Fold (Multi-sheet)

Folds multi-sheets in half along their long edge.

• Letter Fold-in (Multi-sheet)

Folds multi-sheets into thirds with their two end sections folded one on top of the other.

• Letter Fold-out (Multi-sheet)

Folds multi-sheets into thirds with their two end sections folded in opposite directions.

• Staple
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Select this to staple output sheets. If you enable the staple function, you must also specify the
staple position.

• Punch

Select this to punch holes in output sheets. If you enable the punch function, you must also specify
the punch hole position.

• Cut Fore Edge

Select whether to cut the fore edge of the printed sheets.

• Collate

Select this to collate output sheets.

• Job Separation

Select this to separate output sheets according to individual print jobs or copy sets.

• Eject Face-up

Select this to deliver output sheets printed side up. If you enable both Reverse Page Order and
Eject Face-up, printed sheets will be delivered print side up and in the order specified in the
document.

• Printable Area

Select [No Margin] if you want print to continue without margins to the extreme edge of the
paper. If you select [With Margins], print will be confined to the guaranteed printable area.

• Screen Procedure

Select the screen dot shape for the halftone screen.

• Halftone Line Frequency

Select the screen frequency for the halftone screen.

• Screen Angle

Select the screen angle for the halftone screen.

• The staple function is only available when the optional finisher or booklet finisher is installed on the
printer.

• The punch function is only available when the optional finisher or booklet finisher is installed on the
printer.

• The fold function is only available when the optional finisher or booklet finisher and optional multi-
folding unit is installed on the printer.

• The cut-fore-edge function is only available when the optional trimmer or Booklet finisher is installed.
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Advanced Printing
This section explains how to use the printer’s advanced printing functions from a Macintosh computer.

Actual printing procedures might differ depending on the application you are printing from. For details
about the printing procedure, see the manual provided with the application.

Adjusting Image Quality

Use the following procedure to adjust screen procedure, halftone line frequency, and other image quality
settings.

1. Open the document that you want to print.

2. Select [Print] on the [File] menu.

3. Select [Printer Features] in the pop-up menu.

4. Select [Group4] in the [Feature Sets:] pop-up menu.

5. Click the pop-up menu for the setting that you want to change, and then specify the required
value.

6. Print the document using the print function in the document’s native application.

• For details about each setting, see "Paper and Print Settings".

• p.121 "Paper and Print Settings"

Printing on Special Paper

Use the following procedure to print on special paper.

1. Open the document that you want to print.

2. Select [Print] on the [File] menu.

3. Select [Printer Features] in the pop-up menu.

4. Select [Group1] in the [Feature Sets:] pop-up menu.

5. In the [Paper Type] pop-up menu, select the paper type that you want to print on.

6. In the [Paper Color] pop-up menu, select the paper color that you want to print on.

7. Click [Leading Edge] in the pop-up menu, and then specify the paper tray loaded with the
selected paper type.

8. Print the document using the print function in the document’s native application.
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Printing on Custom Size Paper

Use the following procedure to register a custom paper size (and specify margins if necessary).

1. Open the document that you want to print.

2. Select [Page Setup] on the [File] menu.

3. Click the [Printer:] pop-up menu, and select this printer.

4. Open the dialog box for registering a custom paper size.

Click [Paper Size] in the pop-up menu, and then select [Manage Custom Size...].

5. Click [New] or [ ], and then enter a name for the custom paper size.

If you are modifying an existing custom paper size, click the setting name.

You can register multiple custom paper sizes.

6. Enter the dimensions of the custom paper size in the [Width], [Height], and [Length] boxes,
and then enter the margin dimensions in [Top], [Bottom], [Left], and [Right].

If "cm" is selected in [Units], the actual setting may differ slightly from the entered value.

7. Click [OK].

8. Print the document using the print function in the document’s native application.

• Under some versions of Mac OS, custom size paper cannot be registered unless “Printer Default” is
specified as the destination.

• Due to approximation, the actual dimensions of custom size paper might differ slightly from the value
entered by the user.

Collate

Use the following procedure to divide documents containing multiple pages into individual sets for easy
separation.

Collate Types

• Collate

Printed output is assembled as sets in sequential order.

BAC016S
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• Job Separation

The optional finisher or optional booklet finisher is required for this function.

BAC018S

The finisher shift tray moves backward or forward when a job or set is output, causing the next
to shift, so you can separate them.

1. Open the document that you want to print.

2. Select [Print] on the [File] menu.

3. Select [Copies & Pages] in the pop-up menu, and then clear the [Collate] check box.

4. Select [Group3] in the [Features Sets:] pop-up menu.

5. Select the [Collate] check box.

6. Print the document using the print function in the document’s native application.

• If the application has its own collate function, disable it. This will allow the printer to apply its own
collate function.

• If the destination output tray supports the shift function, output sheets will be shift-collated.

Printing on Both Sides of Sheets

Use the following procedure to print on both sides of sheets.

1. Open the document that you want to print.

2. Select [Print] on the [File] menu.

3. Select [Layout] in the pop-up menu.

4. Select the [Two Sided Printing:] check box, or click [Long Edges] or [Short Edges].

5. Print the document using the print function in the document’s native application.

• If you want to use the staple or punch function in combination with duplex printing, you must specify
a staple or punch position that is compatible with the binding pattern and duplex position you have
specified.
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Types of duplex printing

This section explains the binding patterns that are available when the duplex printing function is applied.

• Duplex-Flip on Long Edge (Portrait)

BMF006S

• Duplex-Flip on Short Edge (Portrait)

BMF008S

• Duplex-Flip on Long Edge (Landscape)

BTG004S

• Duplex-Flip on Short Edge (Landscape)
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BTG003S

Staple

Use the following procedure to staple printed sheets together.

1. Open the document that you want to print.

2. Select [Print] on the [File] menu.

3. Select [Printer Features] in the pop-up menu.

4. Select [Group2] in the [Feature Sets:] pop-up menu.

5. In the [Destination] pop-up menu, select the output tray where you want the printed sheets
delivered to.

6. Select the staple position in the [Staple] pop-up menu.

If you select [2 at center], the cut-fore-edge function can be used by enabling "Cut Fore Edge".

7. Print the document using the print function in the document’s native application.

• The staple function is only available when the optional finisher is installed on the printer.

• The cut-fore-edge function is only available when the optional trimmer is installed on the printer.

• If you want to use the staple function in combination with duplex printing, you must specify a staple
position that is compatible with the binding pattern and duplex position you have specified.

Staple position

The specified staple position varies depending on paper size, type, quantity and feed orientation. The
following table shows staple positions:
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BTG017S

*1 Select landscape in [Orientation] under [Page Setup].

*2 Select landscape in [Orientation] under [Page Setup] and [180 degree] in [Image Rotation].

• If you want to use the staple function in combination with duplex printing, you must specify a staple
position that is compatible with the binding pattern and duplex position you have specified.

• If you want to use the staple function in combination with letterhead printing, you must specify a staple
position that is compatible with the binding pattern and paper orientation you have specified.

• When center staple is set, the fore edge of prints can be cut using the optional trimmer.

• Empty the trimmer tray if prints are ejected with waste paper stuck to them. For details, see "Removing
Waste Paper", Troubleshooting.

• For paper sizes and maximum numbers of sheets available for stapling, see "Appendix", About This
Machine.

• For details about [Page Setup] and Orientation, see "Changing Paper Setups".

• p.121 "Changing Paper Setups"

Punch

Use the following procedure to punch holes in printed sheets.

Open the document that you want to print.

1. Select [Print] on the [File] menu.

2. Select [Printer Features] in the pop-up menu.
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3. Select [Group2] in the [Feature Sets:] pop-up menu.

4. Select the finisher in the [Destination] list.

5. Select the punch position in the [Punch] pop-up menu.

6. Print the document using the print function in the document’s native application.

• The punch function is only available when the optional finisher and punch unit are installed on the
printer.

• If you want to use the punch function in combination with duplex printing, you must specify a punch
position that is compatible with the binding pattern and duplex position you have specified.

Punch position

The specified punch position varies depending on paper feed and print data orientation. The following
table shows punch positions:

BTG018S

Advanced Printing

131

7



BTG019S

*1 To have prints delivered in this format, you must select [180 degrees] in [Image Rotation] and specify the punch
holes pattern.

*2 To have prints delivered in this format, you must select landscape in [Page Setup] and specify the punch holes
pattern.

*3 To have prints delivered in this format, you must select landscape in [Page Setup], select [180 degree] in [Image
Rotation], and specify the punch holes pattern.

• If you want to use the punch function in combination with duplex printing, you must specify a punch
position that is compatible with the binding pattern and duplex position you have specified.

• If you want to use the punch function in combination with letterhead printing, you must specify a punch
position that is compatible with the binding pattern and paper orientation you have specified.

• Punch positions will vary slightly from page to page as holes are punched into each sheet individually.

• The number of holes that can be punched varies according to country.

• For details about [Page Setup] and Orientation, see "Changing Paper Setups".

• For details about paper sizes that can be punched, see "Appendix", About This Machine.

• For details about printing methods, see the printer driver Help.

• p.121 "Changing Paper Setups"

Fold

Use the following procedure to apply a fold to printed sheets.

1. Open the document that you want to print.

2. Select [Print] on the [File] menu.
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3. Select [Printer Features] in the pop-up menu.

4. Select [Group2] in the [Feature Sets:] pop-up menu.

5. Select the finisher in the [Destination] list.

6. Select the fold type in the [Fold Type] pop-up menu.

7. Print the document using the print function in the document’s native application.

• The fold function is only available if both the optional multi-folding unit and optional finisher are
installed on the printer.

Folding positions

The following table shows the folds that this printer can apply to prints.

BTG055S

*1 To have prints delivered in this format, you must select [On] for [Eject Face-up] and specify the appropriate fold
pattern.

*2 To have prints delivered in this format, you must select landscape in [Page Setup] and specify the appropriate
fold pattern.
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*3 To have prints delivered in this format, you must select both landscape in [Page Setup] and [On] for [Eject Face-
up] and specify the appropriate fold pattern.

*4 To have prints delivered in this format, you must select landscape in [Page Setup], select [180 degree] in [Image
Rotation], and specify the appropriate fold pattern.

*5 To have prints delivered in this format, you must select both landscape in [Page Setup], select [180 degree] in
[Image Rotation], and [On] for [Eject Face-up] and specify the appropriate fold pattern.

• Gate-fold and multi-sheet fold cannot be applied to coated paper.

• With some applications, the fold direction of the output might be the opposite of the specified direction
when landscape is selected for the Print data direction.

• For details about which sizes and types of paper are compatible with which fold or multifold, see
"Appendix", About This Machine.

• For details about [Page Setup] and Orientation, see "Changing Paper Setups".

• p.121 "Changing Paper Setups"
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Changing to EtherTalk
Follow the procedure below to configure a Mac OS X to use EtherTalk.

• You need an administrator name and a password (phrase). For details, consult your network
administrator.

1. Open [System Preferences], and then click the [Network] icon.

2. Click [Ethernet] in the [Show:] list box.

3. Click the [AppleTalk] tab.

4. Select the [Make AppleTalk Active] check box.

5. To change AppleTalk zones, select a name on the [AppleTalk Zone:] pop-up menu.

6. When the settings are made, click [Apply Now].

• For information about installing applications required for EtherTalk, see the Mac OS manuals.

Changing to EtherTalk
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Configuring the Printer
Use the control panel or Web Interface to enable AppleTalk. (The default is Active.)
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Renaming the Printer
You can change the printer name displayed under AppleTalk.

If you connect several printers on the network, assign different names so you can identify them. If several
printers have the same name, a digit appears next to the printer name in [Chooser].

• You can enter up to 31 digits and letters.

• Do not use symbols, for example “*”, “:”, “=”, “@”, “~”.

1. On the [File] menu, click [Rename Printer...].

2. In the [New Name:] filed enter a new name.

3. Click [Rename].

The printer name is changed.

4. Click [OK].

Renaming the Printer
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Selecting the Zone
You can change the zone to which the printer belongs under AppleTalk.

• Confirm that a Macintosh and printer are connected with AppleTalk.

1. Open a Web browser.

2. Enter "http://(the printer's IP address or host name)/" in the address bar.

When entering an IPv4 address, do not begin segments with zeros. For example: If the address is

"192.168.001.010", you must enter it as "192.168.1.10" to connect to the printer.

The top page of Web Interface appears.

3. Click [Configurations/Jobs].

4. Enter "system" in the user name box and the password for printer settings in the password
box, and then click [OK].

5. Click [Printer Settings].

6. Click [AppleTalk].

7. Enter the AppleTalk zone.

8. Click [OK].

• The change made to AppleTalk Zone setting will becomes effective after the printer is restarted.
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8. Appendix

Printing Files Directly from Windows
You can print files directly using "lpr" commands. For example, you can print PostScript files for PostScript.

Setup

Follow the procedure below to make network environment settings.

1. Enable TCP/IP with the control panel, and then set up the printer's network environment
about TCP/IP including IP addresses.

TCP/IP of the printer is set as default.

2. Install a TCP/IP in Windows to set up the network environment.

Consult the network administrator for the local setting information.

3. To print under Windows 2000/XP/Vista, Windows Server 2003/2003 R2/2008, install
"Printing service for UNIX" as the network application.

• p.145 "Using DHCP"

Using a Host Name Instead of an IPv4 Address

When a host name is defined, you can specify a printer by host name instead of printer's IP address. The
host names vary depending on the network environment.

When using DNS

Use the host name set to the data file on the DNS server.

When setting the IPv4 address of a printer using DHCP

Use the host name on the configuration page as the host name.

In other cases

Add the printer's IP address and host name of the network printer to the hosts file on the computer used for
printing. Methods of addition vary depending on operating systems.

139

8



1. Open the hosts file using memo pad files, for instance.

The hosts file is in the following folder:

\WINDOWS\SYSTEM32\DRIVERS\ETC\HOSTS

Depending on your operating system, you might need to specify "WINNT" directory instead of
"WINDOWS" as the directory.

2. Add an IPv4 or IPv6address and host name to the hosts file using the following format:

192.168.15.16 host # NP

"192.168.15.16" is the IPv4 address, "host" is the printer's host name, and "#NP" is replaced by
comments. Insert a space or tab between "192.168.15.16" and "host", between "host" and "#NP"
respectively, using one line for this format.

2001:DB::100 host # NP

"2001:DB::100" is the IPv6 address, "host" is the printer's host name, and "#NP" is replaced by
comments. Insert a space or tab between "2001:DB::100" and "host", between "host" and "#NP"
respectively, using one line for this format.

3. Save the file.

• When using a host name under Windows Server 2003/2003 R2/2008, or Windows Vista, with
IPv6 protocol, perform host name resolution using an external DNS server. The host file cannot be
used.

Printing Commands

The following explains printing operations using the "lpr" commands.

Enter commands using the command prompt window. The location of the command prompts varies
depending on operating systems:

• Windows 2000

[Start] - [Programs] - [Accessories] - [Command Prompt]

• Windows XP/Vista, Windows Server 2003/2003 R2/2008

[Start] - [All Programs] - [Accessories] - [Command Prompt]

• If the message "print requests full" appears, no print jobs can be accepted. Try again when sessions
end. For each command, the amount of possible sessions is indicated as follows:

• lpr: 5 (When the spool printing function is available: 10)

• Enter the file name in a format including the path from the directory executing commands.
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• If you print a very high volume job, such as 10,000 pages at once, Windows will apply a four-minute
timeout, which can result in an error. To avoid this, use the standard port monitor when printing very
high volume jobs.

lpr

When specifying a printer by IP address

c:> lpr -Sprinter's IP address [-Poption] [-ol] \path\file name

When using a host name instead of an IP address

c:> lpr -Sprinter's host name [-Poption] [-ol] \path\file name

When printing a binary file, add the "-ol" option (lowercase O, and lowercase L).

When using a printer with the host name "host" to print a PostScript file named "file 1" located in the
"C:\PRINT" directory, the command line is as follows:

c:> lpr -Shost -Pfiletype=RPS -ol C:\PRINT\file1

Printing from the virtual printer

C:\>lpr -S "printer's IP address" –P "virtual printer name" [-ol] \path\file name

• "=", ",", "_", and ";" cannot be used for filenames. File names will be read as option strings.

• If personal authentication (Basic, Windows, LDAP, or Integrated Server Authentication) is enabled,
only authenticated users (users authenticated by login user name and password) can log on.

• For "mput" command, "*" and "?" can be used as wild cards in file names.

• When printing a binary file in ASCII mode, print may not come out correctly.

• For details about login user name and password, see Security Reference, which is the administrator's
manual.

• For details about the virtual printer configuration, see "Setting the Virtual Printer".

• For details about PDF direct print precautions, see "PDF Direct Print Precautions".

• p.41 "Setting the Virtual Printer"

• p.91 "PDF Direct Print Precautions"
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Adjusting the Position of the Print Area
Using the PJL command, you can adjust the position of the print area and register the new position for future
usage.

To adjust the position of the print area, change the values for XFRONTIMAGESHIFT,
YFRONTIMAGESHIFT, XBACKIMAGESHIFT, and YBACKIMAGESHIFT.

Front

BTG023D

Back

BTG022D

Command Value

XFRONTIMAGESHIFT
-1000 to +1000: distance of horizontal shift of
front-side image area (unit: 1/100 inch)

YFRONTIMAGESHIFT
-1000 to +1000: distance of vertical shift of front-
side image area (unit: 1/100 inch)

XBACKIMAGESHIFT
-1000 to +1000: distance of horizontal shift of
back-side image area (unit: 1/100 inch)

YBACKIMAGESHIFT
-1000 to +1000: distance of vertical shift of back-
side image area (unit: 1/100 inch)
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Preparing Printer Server
This section explains how to configure the printer as a Windows network printer. The printer is configured
to enabling network clients to use it.

• Under Windows XP Professional or Windows Server 2003/2003 R2, to change printer properties
in the [Printer] or [Printers and Faxes] window, you need Printer Management access authentication;
under Windows Vista/7, and Windows Server 2008/2008 R2, Full Control access authentication.
Log on to the file server as an Administrator group.

1. On the [Start] menu, open the [Printers and Faxes] window.

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

The printer properties appear.

4. On the [Sharing] tab, click [Share this printer].

5. To share the printer with users using a different version of Windows, click [Additional
Drivers...].

If you have installed an alternative driver by selecting [Share As:] during the printer driver installation,
this step can be ignored.

6. Click [OK], and then close the printer properties.

Preparing Printer Server
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Using Windows Terminal Service/Citrix
Presentation Server/Citrix XenApp
This printer is not compatible with Citrix Presentation Server and Citrix XenApp.
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Using DHCP
You can use the printer in a DHCP environment. You can also register the printer NetBIOS name on a
WINS server when it is running.

• The printer's IP address is not compatible with IPv6 and WINS server.

• Printers that register the printer NetBIOS name on a WINS server must be configured for the WINS
server.

• Supported DHCP servers are Microsoft DHCP Server included with Windows 2000 Server, and
Windows Server 2003/2003 R2, and Windows Server 2008, and the DHCP server included with
UNIX.

• If you do not use the WINS server, reserve the IP address in the DHCP server so the same IP address
is assigned every time.

• To use the WINS server, change the WINS server setting to “active” using the control panel.

• Using the WINS server, you can configure the host name via the remote network printer port.

• DHCP relay-agent is not supported. If you use DHCP relay-agent on a network via ISDN, it will result
in increased line charges. This is because your computer connects to the ISDN line whenever a packet
is transferred from the printer.

• If there is more than one DHCP server, use the same setting for all servers. The printer operates using
data from the DHCP server that responds first.

• DHCP servers can operate in an IPv6 environment, but they cannot be configured to allocate IPv6
addresses or obtain host names.

Using AutoNet

If the printer IPv4 address is not automatically assigned by the DHCP server, a temporary printer's IP address
starting with 169.254 and not used on the network can be automatically selected by the printer.

• The printer's IP address is not compatible with AutoNet.

• The system's IP address assigned by the DHCP server is given priority over that selected by AutoNet.

• You can confirm the current IPv4 address on the configuration page.

• When AutoNet is running, the NetBIOS name is not registered on the WINS server.

• The printer cannot communicate with devices that do not have the AutoNet function. However, this
printer can communicate with Macintosh computers.

Using DHCP
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Configuring the WINS Server
This section explains configuring the WINS server.

The printer can be configured to register its NetBIOS name with a WINS server when the power is turned
on.

• The printer's IP address does not support WINS server.

• The WINS server is supported with Windows 2000 Servers WINS Manager.

• For details about the WINS server settings, see Windows Help.

• If there is no reply from the WINS server, the NetBIOS name is registered by broadcast.

• The NetBIOS name can be entered using up to 13 alphanumeric characters.

Using Web Image Monitor

1. Start a Web browser.

2. Enter “http://(system's IP address or host name)/” in the address bar to access the printer
whose settings you want to change.

Top Page of Web Image Monitor appears.

3. Click [Login].

The dialog box for entering the user name and password appears.

4. Enter the user name and password, and then click [Login].

Contact your administrator for information about the settings.

5. In the left area, click [Configuration].

6. Click [IPv4] in the "Network" area.

7. Check that [Active] is selected for [WINS] in the [Ethernet] column, and then enter the WINS
server IPv4 address in [Primary WINS Server] and [Secondary WINS Server].

8. Click [OK].

9. Quit Web Image Monitor.

Using telnet

You can also use telnet to configure WINS.

Use the “wins” command to make the setting with telnet.

For details, see "Remote Maintenance by telnet", Network and System Settings Guide.
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Using the Dynamic DNS Function
Dynamic DNS is a function which dynamically updates (registers and deletes) records (A record, AAAA
record, CNAME, and PTR record) managed by the DNS server. When a DNS server is part of the network
environment to which this printer, a DNS client, is connected, records can be dynamically updated using
this function.

• CNAME registration is not required for the printer's IP address.

Updating

Updating procedure varies depending on whether the IP address is static or acquired by DHCP.

• Dynamic update using message authentication (TSIG, SIG (0)) is not supported.

For a static IPv4 setting

If the IP address or host name is changed, the A and PTR records are updated. If the A record is
registered, CNAME is also registered. CNAMEs that can be registered are as follows:

• Ethernet

RNPXXXXXX (XXXXXX represents the last 3 hexadecimal bytes of the MAC address)

However, if CNAME (RNPXXXXXX) overlaps with the host name, CNAME will not be registered.

For DHCPv4 settings

As a substitute for the printer, the DHCP server updates the record, and one of the following occurs:

• When the printer acquires the IP address from the DHCP server, the DHCP server updates the A
and PTR records.

• When the printer acquires the IP address from the DHCP server, the printer updates the A record,
and the DHCP server updates the PTR record.

If the A record is registered, CNAME is also registered. CNAMEs that can be registered are as follows:

• Ethernet

RNPXXXXXX (XXXXXX represents the last 3 hexadecimal bytes of the MAC address)

For IPv6 settings

This printer updates the AAAA record and PTR record.

It also updates CNAME when the AAAA record is updated.

When a stateless address is newly set, it is automatically registered on the DNS server also.

• CNAME registration is not required for the printer's IP address.

Using the Dynamic DNS Function
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• When the dynamic DNS function is not used, records managed by the DNS server must be updated
manually, if the printer's IP address is changed.

• To update the record using the printer, the DNS server has to have one of the following:

• No security settings made.

• If security settings are made, an IP-specified client (this printer) permits updating.

DNS Servers Targeted for Operation

For static IP setting

• Microsoft DNS servers with standard Windows 2000 Server/Windows Server 2003/2003
R2/2008 features

• BIND 8.2.3 or higher

For DHCP setup, when the printer updates the A record

• Microsoft DNS servers with standard Windows 2000 Server/Windows Server 2003/2003
R2/2008 features

• BIND 8.2.3 or higher

For DHCP setup, when the DHCP server updates records

• Microsoft DNS servers with standard Windows 2000 Server/Windows Server 2003/2003
R2/2008 features

• BIND 8.2.3 or higher

For IPv6 setting

• Microsoft DNS servers with standard Windows Server 2008 features

• BIND 9.2.3 or higher

DHCP Servers Targeted for Operation

As a substitute for the printer, DHCP servers capable of updating the A record and PTR record are as
follows:

• Microsoft DHCP servers with standard Windows 2000 Server (Service Pack 3 or higher versions)/
Windows Server 2003/2003 R2/2008 features

• ISC DHCP 3.0 or higher
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Setting the Dynamic DNS Function

System

Make settings with telnet using the “dns” command.

For details, see "Remote Maintenance by telnet", Network and System Settings Guide.

Printer

Make settings using Web Interface.

For details, see Web Interface Help.

Using the Dynamic DNS Function
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Trademarks
Microsoft®, Windows®, Windows Server®, and Windows Vista® are either registered trademarks or
trademarks of Microsoft Corporation in the United States and/or other countries.

Adobe, Acrobat, Acrobat Reader, PostScript, and Reader are either registered trademarks or trademarks
or trademarks of Adobe Systems Incorporated in the United States and/or countries.

Apple, AppleTalk, EtherTalk, Macintosh, and Mac OS are registered trademarks of Apple Inc, registered
in the U.S. and other countries.

IPS is a trademark or registered trademark of Zoran Corporation and/or its subsidiaries in the United States
or other countries.

Linux® is the registered trademark of Linus Torvalds in the U.S. and other countries.

Monotype is a registered trademark of Monotype Imaging, Inc.

PCL® is a registered trademark of Hewlett-Packard Company.

Citrix® is a registered trademark of Citrix Systems, Inc.

UNIX is a registered trademark of The Open Group.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all right to those marks.

The proper names of the Windows operating systems are as follows:

*The product names of Windows 2000 are as follows:

Microsoft® Windows® 2000 Professional

Microsoft® Windows® 2000 Server

Microsoft® Windows® 2000 Advanced Server

*The product names of Windows XP are as follows:

Microsoft® Windows® XP Professional Edition

Microsoft® Windows® XP Home Edition

Microsoft® Windows® XP Media Center Edition

Microsoft® Windows® XP Tablet PC Edition

*The product names of Windows Vista are as follows:

Microsoft® Windows Vista® Ultimate

Microsoft® Windows Vista® Business

Microsoft® Windows Vista® Home Premium

Microsoft® Windows Vista® Home Basic

Microsoft® Windows Vista® Enterprise

*The product names of Windows 7 are as follows:
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Microsoft® Windows® 7 Home Premium

Microsoft® Windows® 7 Professional

Microsoft® Windows® 7 Ultimate

Microsoft® Windows® 7 Enterprise

*The product names of Windows Server 2003 are as follows:

Microsoft® Windows Server® 2003 Standard Edition

Microsoft® Windows Server® 2003 Enterprise Edition

*The product names of Windows Server 2003 R2 are as follows:

Microsoft® Windows Server® 2003 R2 Standard Edition

Microsoft® Windows Server® 2003 R2 Enterprise Edition

*The product names of Windows Server 2008 are as follows:

Microsoft® Windows Server® 2008 Standard

Microsoft® Windows Server® 2008 Enterprise

*The product names of Windows Server 2008 R2 are as follows:

Microsoft® Windows Server® 2008 R2 Standard

Microsoft® Windows Server® 2008 R2 Enterprise
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